EPSILON V2.0 - USER’S MANUAL

Miguel Angel AGUIRRE and Sébastien DUPLAA

March 4, 2020
# SUMMARY

NOMENCLATURE .............................................................................................................. 7

DISCLAIMER ..................................................................................................................... 9

SUMMARY .......................................................................................................................... 10

EPSILON ............................................................................................................................. 11

CHAPTER 1: BACKGROUND THEORY REVIEW .................................................................. 12

1  CONVENTIONAL REFERENCE FRAME ....................................................................... 12
  1.1 Angle of attack transformation ................................................................................. 12

2  UPSTREAM AERODYNAMIC DATA .............................................................................. 14

3  DRAG BOOKKEEPING ................................................................................................ 15

4  NEAR-FIELD METHOD .................................................................................................. 16

5  FAR-FIELD METHODS .................................................................................................. 17
  5.1 Momentum conservation method ............................................................................ 17
  5.2 Betz method .............................................................................................................. 19
  5.3 Jones method ............................................................................................................ 19
  5.4 Oswatitsch method ................................................................................................ 20
  5.5 Maskell method ........................................................................................................ 20
    5.5.1 Drag breakdown ................................................................................................. 20
    5.5.2 Lift ...................................................................................................................... 22
  5.6 Van Der Vooren method ........................................................................................ 22
  5.7 Giles method ........................................................................................................... 23
  5.8 Kusunose method .................................................................................................... 23
    5.8.1 Drag breakdown ................................................................................................. 23
    5.8.2 Lift ...................................................................................................................... 24
  5.9 Meheut method ........................................................................................................ 24
  5.10 Profile drag breakdown .......................................................................................... 24

6  LAMB VECTOR METHODS ......................................................................................... 26
  6.1 Wu method ................................................................................................................ 26
  6.2 Mele method ............................................................................................................. 26

7  EXERGY METHODS ..................................................................................................... 27
  7.1 Arntz method .......................................................................................................... 27
    7.1.1 Wave anergy ...................................................................................................... 28
    7.1.2 Total anergy ...................................................................................................... 29
7.1.3 Thermal exergy ........................................................................................................29
7.1.4 Exergy flow field interpretation ........................................................................29
7.2 Aguirre method ........................................................................................................29
  7.2.1 Wave anergy (volume formulation) ................................................................29
  7.2.2 Wave anergy (wake surface formulation) .......................................................30
  7.2.3 Redefinition of the mechanical and thermal exergy (infinite surface formulation) ..................................................................................................................30
  7.2.4 Profile drag ......................................................................................................30
  7.2.5 Profile drag correction .....................................................................................32
  7.2.6 Vortex exergy (induced drag) .........................................................................32
8 CLASSICAL ANALYSIS METHODS ........................................................................32
  8.1 Shockwave detection .............................................................................................32
  8.2 Vortex detection ...................................................................................................32
    8.2.1 Q-criterion ....................................................................................................33
    8.2.2 Lambda 2 criterion .....................................................................................33
  8.3 Wake detection .....................................................................................................33
    8.3.1 Total pressure ratio .....................................................................................33
9 NONDIMENSIONALIZATION ..................................................................................33

CHAPTER 2: THE ARCHITECTURE OF EPSILON ......................................................35

1 ARCHITECTURE .....................................................................................................35

2 INPUT DATA ...........................................................................................................35
  2.1 Data formats .......................................................................................................35
    2.1.1 CFD data ..................................................................................................36
    2.1.2 Wind Tunnel data .....................................................................................36
  2.2 Readers files .......................................................................................................36

3 EPSILON AERO DATA ............................................................................................36
  3.1 Paraview’s programmable filters ......................................................................36
    3.1.1 The Python code .......................................................................................37
    3.1.2 The XML file ............................................................................................37
    3.1.3 Paraview’s plugin .....................................................................................37
  3.2 Epsilon Aero Data Code ....................................................................................37

4 DATA VISUALIZATION AND INTEGRATION .......................................................38
  4.1 Epsilon Axes ......................................................................................................38
  4.2 Field visualization ..............................................................................................38
4.3 Integration of the equations ..................................................................................................................39
  4.3.1 Surface integrals .................................................................................................................................39
  4.3.2 Volume integrals ..................................................................................................................................39
5 EPSILON INTEGRATION TOOL ......................................................................................................................40
  5.1 The conceptual approach ..........................................................................................................................40
  5.2 Line distribution .........................................................................................................................................40
  5.3 3D to 2D mapping .....................................................................................................................................41
6 COMPLEMENTARY METHODS ......................................................................................................................41
  6.1 Epsilon Near-Field ..................................................................................................................................41
  6.2 Epsilon Profile Drag Breakdown ................................................................................................................41
  6.3 Epsilon Poisson Solver ...............................................................................................................................42
CHAPTER 3: INSTALLATION PROCEDURE ......................................................................................................43
1 DISCLAIMER .................................................................................................................................................43
2 EPSILON DOWNLOAD ...................................................................................................................................43
3 EPSILON INSTALLATION .............................................................................................................................43
  3.1 Files organization ....................................................................................................................................43
  3.2 File path definition ...................................................................................................................................43
  3.3 Loading the plugins ..................................................................................................................................44
  3.4 Reset session ............................................................................................................................................44
CHAPTER 4: ANALYSIS OF 2D CFD DATA ......................................................................................................45
1 PROCEDURE ..................................................................................................................................................45
2 PREVIOUS CONSIDERATIONS ......................................................................................................................45
3 LOADING CFD/WTT DATA ..........................................................................................................................45
  3.1 Experimental data ....................................................................................................................................46
  3.2 Fluent CAS files .......................................................................................................................................46
  3.3 Fluent CGNS files ....................................................................................................................................46
  3.4 Fluent Ensight Gold Case files ..................................................................................................................46
  3.5 Open Foam files ......................................................................................................................................46
  3.6 STAR CCM Ensight Gold Case files .........................................................................................................47
  3.7 elsA Tecplot files .....................................................................................................................................47
  3.8 elsA CGNS files .......................................................................................................................................47
  3.9 TAU Tecplot files ....................................................................................................................................47
  3.10 Potential Flow Generator files .................................................................................................................47
NOMENCLATURE

\( \dot{A} \) total anergy rate, W
\( \dot{A}_{\phi} \) viscous anergy rate, W
\( \dot{A}_{\text{th}} \) thermal anergy rate, W
\( \dot{A}_{w} \) shockwave anergy rate, W
\( a \) speed of sound, m.s\(^{-1}\)
\( c \) airfoil chord, m
\( C_L \) lift coefficient
\( C_D \) drag coefficient
\( C_{Dc} \) exergy-based drag coefficient
\( C_{Dv} \) vortex (induced) drag coefficient
\( C_{Dv \text{visc}} \) viscous drag coefficient
\( C_{Dp} \) profile drag coefficient
\( C_{Dw} \) wave drag coefficient
\( C_M \) moment coefficient
\( C_p \) pressure coefficient
\( C_Y \) sideforce coefficient
\( c_p, c_v \) mass specific heat at constant pressure and volume respectively, J.kg\(^{-1}\).K\(^{-1}\)
\( D \) drag force, N
\( e \) mass specific internal energy, J.kg\(^{-1}\)
\( \dot{E}_u \) axial kinetic exergy rate, W
\( \dot{E}_v \) transverse kinetic exergy rate, W
\( \dot{E}_p \) boundary-pressure work rate, W
\( F_y \) Sideforce, N
\( G \) Green function
\( h_s, h_t \) mass specific static and total enthalpy respectively, J.kg\(^{-1}\)
\( i, j, k \) unit vectors along the aerodynamic x-, y- and z-axes
\( I, J, K \) unit vectors along the mesh X-, Y- and Z-axes
\( L \) Lift force, N
\( \vec{l} \) Lamb vector
\( M \) Mach number (= \( u_0/a_0 \))
\( \vec{n} \) \( n_x i, n_y j, n_z k \), local surface normal
\( \vec{P} \) \( x_i, y_j, z_k \), point coordinates in the aerodynamic reference frame, m
\( \vec{P}_{\text{mesh}} \) X I, Y J, Z K, point coordinates in the mesh reference frame, m
\( P_s, P_t \) static and total pressure, Pa
\( Pr \) Prandtl number (= \( c_p \mu / k \))
\( q \) dynamic pressure, Pa
\( R \) gas constant, J.kg\(^{-1}\).K\(^{-1}\)
\( Re \) Reynolds number (= \( \rho_0 u_0 c / \mu_0 \))
\( R_x, R_y, R_z \) rotation matrix about mesh X-, Y- and Z-axes
\( S \) reference surface, m\(^2\)
**Greek letters**

- \( \alpha \) angle of attack, deg
- \( \beta \) angle of sideslip, deg
- \( \delta(\cdot) = (\cdot)_{0} \) local variation of a parameter respect to the upstream reference value
- \( \Delta(\cdot) = \delta(\cdot)/\delta(\cdot)_{0} \) non-dimensional local variation of a parameter respect to the upstream value
- \( \dot{\varepsilon}_{m} \) mechanical exergy rate, W
- \( \dot{\varepsilon}_{th} \) thermal exergy rate, W
- \( \phi \) potential velocity function, m\(^2\).s\(^{-1}\)
- \( \Phi_{eff} \) effective dissipation, W.m\(^{-3}\)
- \( \Gamma \) circulation, m\(^2\).s\(^{-1}\)
- \( \gamma \) ratio of specific heats
- \( k_{eff} \) effective thermal conductivity, W.m\(^{-1}\).K\(^{-1}\)
- \( \mu, \mu_{t} \) laminar and turbulent dynamic viscosities, kg.m.s\(^{-1}\)
- \( \rho \) air density, kg.m\(^{-3}\)
- \( \sigma \) flow source/sink, s\(^{-1}\)
- \( \overline{\tau} \) viscous stress tensor, Pa
- \( \nu \) kinematic viscosity, m\(^2\).s\(^{-1}\)
- \( \psi \) stream function, m\(^2\).s\(^{-1}\)
- \( \overline{\omega} \) \( \xi, \eta, \zeta \), local vorticity vector in the aerodynamic reference frame, s\(^{-1}\)
- \( \overline{\omega}_{mesh} \) \( \omega, \omega_{1}, \omega_{J}, \omega_{K} \), local vorticity vector in the mesh reference frame, s\(^{-1}\)

**Subscripts**

- \( 0 \) upstream reference values
- \( b \) body
- \( eff \) effective
- \( out \) outlet section (survey plane)
- \( ref \) reference
- \( w \) wake

**Acronyms**

- CFD Computational Fluid Dynamics
- WTT Wind Tunnel Testing
This plugin was developed for research purposes and released under GNU GPL V3 license \textit{without any guarantee of any kind}, either express or implied. Its use for teaching, research and industrial applications is allowed under the strict responsibility of the user. The authors of this plugin are not responsible for any damage or error related to the use of the plugin.
SUMMARY

The **first chapter** of this user’s manual deals with the theoretical background about the far-field and the exergy methods, as well as its related formulae. Then, the **second chapter** presents the architecture and scope of the set of plugins. **Chapter 3** explains the installation procedure and the **Chapters 4 and 5** gives a detailed user’s guide in order to fully exploit the capabilities of the plugin set.
Epsilon (*) is an open source aerodynamic analysis tool suited for CFD and experimental data. It allows the user to perform an aerodynamic analysis by using several methods: near field, far-field, Lamb vector and exergy methods.

Epsilon is a set of plugins for Paraview created to provide an easy to use tool for the post processing of 2D and 3D data as shown in Fig.1.

Figure 1: How to perform an aerodynamic analysis of CFD or experimental data with Epsilon

The code was developed by ISAE for research purposes (Development of new exergy formulations) and now is released to the public domain under GNU GPL V3 license. It can be downloaded from this internet site:


The site also contains plenty of information complementary to this user manual (i.e., open data and theory). In particular, it is advised to watch the video tutorials that will help the user to quickly exploit all the capabilities offered by Epsilon:

https://websites.isae-supero.fr/epsilon-exergy-analysis-tool/tutorials/

Please, cite the following paper in any published research or other work utilizing Epsilon:


(*) Since this software was originally developed in order to perform an exergy analysis (whose symbol is “ε”), it has been named “Epsilon”.
CHAPTER 1: BACKGROUND THEORY REVIEW

This chapter gives an introduction to the theory needed to understand the near-field, far-field, Lamb vector and exergy methods. The equations and methodology presented here are used later to explain the architecture and functioning of the related plugins.

1 CONVENTIONAL REFERENCE FRAME

All the formulations discussed below use a standard reference frame as described in the Figure 2. It considers a reference system where the x-axis is aligned with the upstream flow direction and pointing rearwards, the y-axis points towards the RHS of the body and the z-axis points upwards. The x-, y-, z-axes will be called “aerodynamic axes” (or “wind axes”). Moreover, when control volume formulations are used, it is supposed that the outlet section of the control volume is a plane (called “survey plane”) and it is placed normal to the x-axis (i.e., normal to the upstream flow direction). Also, the lateral surfaces are considered parallels to the upstream direction.

1.1 Angle of attack transformation

In a wind tunnel testing the aerodynamic axes are coincident with the tunnel axes. However, in a CFD case the mesh axes (X, Y, Z) can be different from the aerodynamic axes (x, y, z). Moreover, there is no standard practice to assign the axis pointing upwards: it can be Y or Z (usually, X is reserved for the longitudinal axis). Hence, in the most general case a transformation matrix “\( \mathbf{T} \)” is needed in order to express all the mesh vector fields in
the aerodynamic reference frame. This transformation matrix is composed of three rotational transformation matrices \( \bar{R}_x \), \( \bar{R}_y \) and \( \bar{R}_z \) as follows:

\[
\bar{R}_x = \begin{bmatrix}
1 & 0 & 0 \\
0 & \cos(\text{angle}_x) & -\sin(\text{angle}_x) \\
0 & \sin(\text{angle}_x) & \cos(\text{angle}_x)
\end{bmatrix}
\]

(1)

\[
\bar{R}_y = \begin{bmatrix}
\cos(\text{angle}_y) & 0 & \sin(\text{angle}_y) \\
0 & 1 & 0 \\
-\sin(\text{angle}_y) & 0 & \cos(\text{angle}_y)
\end{bmatrix}
\]

(2)

\[
\bar{R}_z = \begin{bmatrix}
\cos(\text{angle}_z) & -\sin(\text{angle}_z) & 0 \\
\sin(\text{angle}_z) & \cos(\text{angle}_z) & 0 \\
0 & 0 & 1
\end{bmatrix}
\]

(3)

These are the rotational matrices about the mesh X-, Y- and Z-axes (“\( \text{angle}_x \)”, “\( \text{angle}_y \)” and “\( \text{angle}_z \)” are the rotation angles about those axes). If the Z-mesh axis points upwards, then: \( \text{angle}_x=0 \), \( \text{angle}_y=-\alpha \), \( \text{angle}_z=\beta \).

The rotational matrices can be used to obtain the transformation matrix “\( \bar{T} \)” from the mesh reference system (XYZ) to the aerodynamic reference system (xyz):

\[
\bar{T}_x = \bar{R}_x^T \cdot \bar{R}_x^T
\]

(4)

\[
\bar{T}_y = \bar{R}_y^T \cdot \bar{R}_y^T
\]

(5)

\[
\bar{T}_z = \bar{R}_z^T \cdot \bar{R}_z^T
\]

(6)

\[
\bar{T} = \bar{T}_x \cdot \bar{T}_y \cdot \bar{T}_z
\]

(7)

The transformation matrix “\( \bar{T} \)” can be used to transform the velocity vector in the mesh reference system to the aerodynamic reference frame as follows:

\[
\vec{V} = \bar{T} \cdot \vec{V}_{\text{mesh}}
\]

(8)

With:

\[
\vec{V}_{\text{mesh}} = V_x \hat{i} + V_y \hat{j} + V_z \hat{k}
\]

(9)

\[
\vec{V} = u \hat{i} + v \hat{j} + w \hat{k}
\]

(10)

Where “\( \vec{V} \)” is the velocity vector, “\( V_x, V_y, V_z \)” are the X-, Y- and Z-velocity components in the mesh reference frame and “\( u, v, w \)” are the x-, y- and z-velocity components in the aerodynamic reference frame.

By following the same approach, the mesh vorticity vector can be referred to the aerodynamic axes:

\[
\vec{\omega} = \bar{T} \cdot \vec{\omega}_{\text{mesh}}
\]

(11)

With:

\[
\vec{\omega}_{\text{mesh}} = \omega_x \hat{i} + \omega_y \hat{j} + \omega_z \hat{k}
\]

(12)

\[
\vec{\omega} = \xi \hat{i} + \eta \hat{j} + \zeta \hat{k}
\]

(13)
The same is also valid for the points coordinates:

\[ \vec{p} = \mathbf{T} \vec{p}_{\text{mesh}} \]  

(14)

With:

\[ \vec{p}_{\text{mesh}} = X \hat{i} + Y \hat{j} + Z \hat{k} \]  

(15)

\[ \vec{p} = x \hat{i} + y \hat{j} + z \hat{k} \]  

(16)

Any other vector is transformed by using the same approach. Moreover, the mesh tensors (like the viscous stress tensor) can also be referred to the aerodynamic axes:

\[ \vec{t} = \mathbf{T} \vec{t}_{\text{mesh}} \mathbf{T}^T \]  

(17)

2 UPSTREAM AERODYNAMIC DATA

All the aerodynamic analysis formulations discussed later require knowing in advance the upstream reference aerodynamic and thermodynamic parameters. The user of Epsilon usually knows some parameters there:

- Upstream total pressure: \( P_{t_0} \)
- Upstream total temperature: \( T_{t_0} \)
- Upstream speed: \( U_0 \)

These are the only imposed upstream data. The remaining upstream parameters may be obtained directly by considering a locally isentropic-isoenergetic flow:

- Upstream static temperature: \( T_{s_0} = T_{t_0} - \frac{U_0^2}{2c_p} \)  
  \[ T_{s_0} = T_{t_0} - \frac{U_0^2}{2c_p} \]  
  (18)
- Upstream speed of sound: \( a_0 = \sqrt{\gamma R T_{s_0}} \)  
  \[ a_0 = \sqrt{\gamma R T_{s_0}} \]  
  (19)
- Upstream Mach number: \( M_0 = \frac{U_0}{a_0} \)  
  \[ M_0 = \frac{U_0}{a_0} \]  
  (20)
- Upstream static pressure: \( P_{s_0} = P_{t_0}/\left(1 + \frac{\gamma - 1}{2} M_0^2\right)^{\frac{\gamma}{\gamma - 1}} \)  
  \[ P_{s_0} = P_{t_0}/\left(1 + \frac{\gamma - 1}{2} M_0^2\right)^{\frac{\gamma}{\gamma - 1}} \]  
  (21)
- Upstream density: \( \rho_0 = \frac{P_{s_0}}{RT_{s_0}} \)  
  \[ \rho_0 = \frac{P_{s_0}}{RT_{s_0}} \]  
  (22)
- Upstream static enthalpy: \( h_{s_0} = c_p T_{s_0} \)  
  \[ h_{s_0} = c_p T_{s_0} \]  
  (23)
- Upstream total enthalpy: \( h_{t_0} = c_p T_{t_0} \)  
  \[ h_{t_0} = c_p T_{t_0} \]  
  (24)
- Upstream internal energy: \( e_0 = c_v T_{s_0} \)  
  \[ e_0 = c_v T_{s_0} \]  
  (25)
- Upstream dynamic pressure: \( q_0 = \frac{1}{2} \rho_0 U_0^2 \)  
  \[ q_0 = \frac{1}{2} \rho_0 U_0^2 \]  
  (26)

Where:

- Mass specific heat capacity at constant pressure: \( c_p = \frac{\gamma R}{\gamma - 1} \)  
  \[ c_p = \frac{\gamma R}{\gamma - 1} \]  
  (27)
- Mass specific heat capacity at constant volume: \( c_v = \frac{c_p}{\gamma} \)  
  \[ c_v = \frac{c_p}{\gamma} \]  
  (28)
Sometimes the upstream static parameters are known instead of the total parameters. Also, the upstream Mach number may be known instead of the upstream velocity. In any case, the equations presented before can be used to compute the remaining upstream data.

The values used in Epsilon for the gas constants parameters were extracted from the properties table of the Fluent solver (using these values, a high accuracy of results is guaranteed):

<table>
<thead>
<tr>
<th>Fluent Air Data</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>8.314462618 J/(K mol)</td>
</tr>
<tr>
<td>m/M</td>
<td>28.966 g/Mol</td>
</tr>
<tr>
<td>r</td>
<td>287.04213969 J/Kg K</td>
</tr>
<tr>
<td>c_p</td>
<td>1006.43 J/Kg K</td>
</tr>
<tr>
<td>c_v</td>
<td>719.38786031 J/Kg K</td>
</tr>
<tr>
<td>( \gamma )</td>
<td>1.399008873407</td>
</tr>
</tbody>
</table>

Table 1: reference values

### 3 DRAG BOOKKEEPING

Epsilon is a software capable of predicting lift and drag based on CFD and experimental data. It also allows calculating these values by several methods and to decompose it as well. The drag breakdown is performed by using the standard drag bookkeeping listed below, and depicted in Fig. 3, 4 and 5:

- **Pressure drag**: drag force related to the pressure distribution acting upon a body
- **Friction drag**: drag force related to the skin friction distribution acting upon a body
- **Total near-field drag**: Pressure drag + Friction drag
- **Viscous drag**: drag force due to the losses inside the viscous boundary layer
- **Wave drag**: drag force related to the losses occurred across the shockwave
- **Profile drag**: defined as Viscous drag + Wave drag
- **Induced drag**: drag force related to the axial vorticity created by the body
- **Total far-field drag**: Profile drag + Induced drag

![Figure 3: Pressure drag (left) and friction drag (right)](image-url)
The most widely used method for aerodynamic assessment is the so-called near-field method, which allows calculating lift, drag and moments by making a surface integral [2,3]:

$$
\vec{F}_b = \int_{S_b} (P_s \vec{n} - \vec{\tau} \cdot \vec{n}) dS_b
$$

(29)

Where “$\vec{F}_b$” is the vector force acting on the body, “$P_s$” is the static pressure, “$\vec{\tau}$” is the viscous stress tensor, “$\vec{n}$” is the vector normal to the surface, “$S_b$” the surface of the body.

This approach has the advantage to be very simple and easy to understand. Moreover, its implementation in a CFD code is straightforward. However it does not allow a phenomenological decomposition of the drag (other than pressure and friction drag) and it does not provide a complete understanding of the physics, which highlights its drawbacks for design purposes.
5 FAR-FIELD METHODS

A more powerful aerodynamic assessment can be made by using the so-called far-field methods. All of them use the momentum conservation approach to define a set of equations allowing making a phenomenological decomposition of drag, while giving at the same time a good insight into the physics. The methods implemented in Epsilon are the followings:

- Classical momentum conservation method
- Betz method
- Jones method
- Oswatitsch method
- Maskell method
- Van Der Vooren method
- Giles method
- Kusunose method
- Meheut method
- Onorato

All these approaches are valid only for stationary flows. No unsteady formulations are considered in Epsilon. Moreover, several of these formulations were developed for wind tunnel wake analysis (they require data inside the wake only) but their use for the analysis of CFD data is highly recommended since they provide a deeper physical understanding of the flow field.

5.1 Momentum conservation method

This approach [4] applies the momentum conservation equation to a control volume surrounding the body:

$$\int_{S_b + S_0 + S_{lat} + S_{out}} \left[ \rho \vec{V} \cdot \vec{n} + P_z \vec{n} - \vec{r}.\vec{n} \right] dS = \vec{0}$$  \hspace{1cm} (30)

Where “S_o”, “S_{lat}” and “S_{out}” are the upstream, lateral and outlet faces of the control volume respectively (external faces of the control volume), “S_b” is the body surface (internal face of the control volume) and “\rho” the local density. This equation can be rearranged in the following way, where the first term is equal to the near-field forces acting upon the body (Eq. 29):

$$\int_{S_b} \left[ P_z \vec{n} - \vec{r}.\vec{n} \right] dS = -\int_{S_0 + S_{lat} + S_{out}} \left[ \rho \vec{V} \cdot \vec{n} + P_z \vec{n} - \vec{r}.\vec{n} \right] dS$$  \hspace{1cm} (31)

This highlights the fact that the near-field forces can be obtained by analyzing the flow parameters on the external surfaces of the control volume (i.e., near-field forces = far-field forces). This equation can be further modified in order to explicitly take into account the upstream parameters:
\[
\bar{F}_b = \int_{S_0 + S_{lat} + S_{out}} \left[ \rho \left( \vec{V} - \vec{V}_0 \right) \left( \vec{V} \cdot \hat{n} \right) + (P_z - P_{s0}) \hat{n} - \vec{F} \cdot \hat{n} \right] dS
\]  

(33)

Where “\( \vec{V}_0 \)” is the upstream vector, given by:

\[
\vec{V}_0 = U_0 \hat{i} + 0 \hat{j} + 0 \hat{k}
\]

This is an exact equation that allows obtaining the lift and total drag of a body. It is valid for compressible and incompressible flows, for flows with or without lifting bodies and/or power. Moreover, it does not impose limitations concerning the position of the outlet plane: the survey plane can be placed anywhere downstream of the body. However, it requires integrating the entire outlet section of the control volume (its integral cannot be reduced to the wake only). Another major drawback is its inability to decompose drag.

In most applications, the viscous tensor term is usually neglected. Also, the upstream and lateral surfaces are considered to be far away. This leads to the simplified momentum conservation equations for lift “\( L \)”, sideforce “\( F_y \)” and total drag “\( D_{Tot} \)”, that will be widely used by all the other far-field methods as starting point for its equation development:

\[
L = -\int_{S_{out}} \rho \, w \, u \, dS
\]  

(34)

\[
F_y = -\int_{S_{out}} \rho \, v \, u \, dS
\]  

(35)

\[
D_{Tot} = -\int_{S_{out}} \left[ \rho \left( u - U_0 \right) \left( u \right) + (P_s - P_{s0}) \hat{n} \right] dS
\]  

(36)

An assessment of the stress tensor influence on the resulting force can be made by taking into account its effect on the drag:

\[
D_{stress} = -\int_{S_{out}} \tau_{xx} \, dS
\]  

(37)

With:

\[
\tau_{xx} = \mu \left[ \frac{2}{3} \frac{\partial u}{\partial x} - \frac{2}{3} \left( \frac{\partial u}{\partial x} + \frac{\partial v}{\partial y} + \frac{\partial w}{\partial z} \right) \right] + R_{xx}
\]  

(38)

Where “\( R_{xx} \)” is the Reynolds stress term, given by the time average of velocities and densities fluctuations:

\[
R_{xx} = -\rho u'^2 - 2u\rho'\bar{u}' - \rho' u'^2
\]  

(39)

The previous equations are implemented in Epsilon. The integrand of each equation is evaluated at any point of the CFD domain in order to perform flow visualizations. The user can then perform a surface integration in order to obtain the desired drag or lift values. The chapters 2, 4 and 5 will explain the data analysis procedures in detail. Also, in the Appendix 1 there is a list of the variables names calculated by Epsilon at each point. (It can be an entire equation or a single term of it). For the momentum conservation method, all the Epsilon variables are called “MOMENTUM_” + the variable name.
5.2 Betz method

This method was developed by Betz in 1925 [5, 6] and it allows calculating the profile drag of a body in a wind tunnel testing. It uses the simplified total drag momentum equation (Eq. 36) and introduces the concept of artificial velocity (known nowadays as “isentropic velocity” [30]) as an attempt to reduce the integral to the wake. This artificial velocity is a fictitious one which is equal to the actual speed outside of the wake, but it is larger inside of it. In fact it is intended to give the velocity profile if no loss of energy where present (i.e., the potential or inviscid component of the local velocity):

\[ u^* = u^2 + \frac{2}{\rho} (P_t - P_t) \]  

(40)

Where “\( u^* \)” is the artificial velocity and “\( P_t \)” the local total pressure. Betz also proposes to introduce the axial velocity perturbation concept, i.e., to express the local artificial velocity as a perturbation “\( u' \)” of the upstream velocity:

\[ u^* = U_0 + u' \]  

(41)

This allows converting the simplified total drag momentum equation into the Betz’s profile drag equation:

\[ D_p = \int_{S_{wake}} \left[ (P_t - P_t) + \frac{\rho}{2} (u^* - u) (u^* + u - 2U_0) \right] dS \]  

(42)

Where “\( S_{wake} \)” is the cross-section surface of the wake at the survey station. This equation is valid only for incompressible flows (\( M_0 < 0.3 \)) because it uses the Bernoulli equation. Moreover, it requires placing the outlet plane only in regions where the viscous effect can be neglected (it cannot be placed very close to the body) because it uses the simplified momentum equation (i.e., without the viscous term). Furthermore, this formulation performs well only with non-lifting bodies because it only takes into consideration the x-velocity component for drag prediction. Also, this profile drag expression is valid only if the static pressure is constant on the entire survey plane and equal to the upstream reference pressure (This plane is called Trefftz plane).

5.3 Jones method

Developed in 1936, the method proposed by Jones [7, 8] is a refinement of the Betz method in order to avoid the restriction of placing the survey plane coincident with the Trefftz plane. This is achieved by considering an isentropic flow between the survey plane and the Trefftz plane (Thus, the survey plane cannot be placed between two bodies). This hypothesis allows writing a simpler equation for the profile drag and allowing placing the survey plane everywhere downstream of a body:

\[ D_p = 2 \int_{S_{wake}} \left[ \sqrt{P_t - P_s} \left( \sqrt{P_{t0} - P_{s0}} - \sqrt{P_t - P_{s0}} \right) \right] dS \]  

(43)

This formulation is subjected to the same other constraints as the Betz equation. Moreover, it is not valid when strong shockwaves are present: in those cases the local total pressure is smaller than the upstream static pressure, which leads to mathematical singularities (Negative root). Also, the assumption of isentropic flow along the wake is not accurate since entropy constantly increases along the wake (See exergy method).
5.4 Oswatitsch method

In 1956 Oswatitsch [9, 10] developed for the very first time an equation that relates field entropy variations with profile drag. It requires placing the survey plane in a position where the second-order terms can be neglected (i.e., far downstream of the body). Under such conditions the profile drag equation reduces to:

\[ D_p = \frac{T_s}{U_0} \int_{\text{wake}} \rho u \delta s \, dS \]  

(44)

Where “\(\delta s\)” is the local specific entropy variation respect to the upstream condition.

5.5 Maskell method

In 1972, Maskell [11, 12, 13] proposed an improved far-field drag formulation for 3D lifting bodies. It provides a further decomposition of drag into profile and induced drag and he also proposed an equation to obtain lift.

5.5.1 Drag breakdown

A new drag breakdown is made by taking into account the induced drag (also called “vortex drag”). So far, the existing methods only take into consideration the axial velocity component, which leads only to a profile drag prediction. Maskell incorporates the transverse speed components which lead to the vortex drag formulation. This was achieved by reformulating the simplified total drag momentum conservation equation by considering a more general Bernoulli equation:

\[ p_t = p_s + \rho \left( u^* + v^2 + w^2 \right) \]  

(45)

This allows obtaining a new total drag expression:

\[ D_{\text{Tot}} = \int_{\text{out}} \left[ (p_{t0} - p_t) + \frac{\rho}{2} \left( U_0^2 - u^2 \right) + \frac{\rho}{2} (v^2 + w^2) \right] dS \]  

(46)

Note that only the first term can be integrated in the wake area because outside of the wake the local total pressure equals the upstream total pressure. The other terms require a complete integration on the survey plane area. On the other hand, this equation can be decomposed into its profile and vortex drag. The profile drag itself is obtained by modifying this equation by using the same approach as Betz, allowing a wake integration:

\[ D_p = \int_{\text{wake}} \left[ (p_{t0} - p_t) + \frac{\rho}{2} (u^* - u) (u^* + u - 2U_0) \right] dS \]  

(47)

And the remaining term is the vortex drag:

\[ D_v = \int_{\text{out}} \frac{\rho}{2} (v^2 + w^2) dS \]  

(48)

This last equation was achieved by defining a blockage velocity in order to correct data because of the confinement effect (wind tunnel blockage).

\[ u_{\text{blockage}} = \frac{1}{2 \, \text{sw}^2} \int_{\text{wake}} (u^* - u) \, dS \]  

(49)
Where “$u_{blockage}$” is the blockage velocity and “$S_{wt}$” is the wind tunnel cross section area. This correction is made by modifying the reference velocity:

$$u_{eff} = U_0 + u_{blockage}$$ (50)

Where “$u_{eff}$” is the effective upstream velocity (Note that $u_{eff}=U_0$ for free air condition because $S_{wt}\rightarrow \infty$).

Moreover, an alternative expression for the vortex drag can be obtained by introducing the scalar functions “$\psi$” (stream function) and “$\phi$” (potential function) defined by Poisson equations as follows:

$$\frac{\partial^2 \psi}{\partial y^2} + \frac{\partial^2 \psi}{\partial z^2} = -\xi$$ (51)

$$\frac{\partial^2 \phi}{\partial y^2} + \frac{\partial^2 \phi}{\partial z^2} = \sigma$$ (52)

Where “$\xi$” is the axial vorticity and “$\sigma$” the in-plane flow source/sink, given by:

$$\xi = \frac{\partial w}{\partial y} - \frac{\partial v}{\partial z}$$ (53)

$$\sigma = \frac{\partial v}{\partial y} + \frac{\partial w}{\partial z} = -\frac{\partial u}{\partial x}$$ (54)

By using these equations, the vortex drag can be re-expressed as:

$$D_v = \int_{S_{out}} \frac{\rho_0}{2} (\psi \xi - \phi \sigma) \ dS$$ (55)

Note that only the first term can be integrated just in the wake region because the vorticity vanishes outside of the wake. The second term still requires a complete integration on the entire survey plane but when the survey plane is placed at least at 1 chord downstream, this term can be neglected [14]. Thus Epsilon allows the user to decide whether to include the “$\phi \sigma$” term or not. Moreover, Epsilon also allows the selection of the definition of “$\sigma$”: it can be used the axial velocity derivative or its transverse derivative.

The stream and potential functions can be determined with an analytical approach, by using the Green functions as follows:

$$\psi(y, z) = -\int_{S_{out}} G(y, z, y_w, z_w) \xi(y_w, z_w) \ dy_w \ dz_w$$ (56)

$$\phi(y, z) = \int_{S_{out}} G(y, z, y_w, z_w) \sigma(y_w, z_w) \ dy_w \ dz_w$$ (57)

Where the Green functions varies depending on the type of survey data available:

$$\begin{align*}
\text{Free air – full model aircraft:} & \quad G(y, z, y_w, z_w) = \frac{1}{4\pi} \log[(y - y_w)^2 + (z - z_w)^2] \\
\text{Free air – half model aircraft:} & \quad G(y, z, y_w, z_w) = \frac{1}{4\pi} \log[(y - y_w)^2 + (z - z_w)^2]_{\text{model}} \\
\text{Free air – mirror model aircraft:} & \quad G(y, z, y_w, z_w) = \frac{1}{4\pi} \log[(y - y_w)^2 + (z - z_w)^2]_{\text{mirror}}
\end{align*}$$ (58) (59)

21
The Green function method is not yet available for to bounded flows (wind tunnel data). This will be coded in the next version of Epsilon.

Finally, the induced velocity components in this plane are given by:

\[
\begin{align*}
\nu_{\text{induced}} &= \frac{\partial \psi}{\partial z} + \frac{\partial \phi}{\partial y} \\
\omega_{\text{induced}} &= -\frac{\partial \psi}{\partial y} + \frac{\partial \phi}{\partial z}
\end{align*}
\] (60)

The profile drag formulation is valid only for incompressible flows (like Betz), however the vortex drag is also valid for compressible regime. Moreover, the profile drag definition requires placing the survey plane in a zone of constant static pressure (Treffitz plane). However, the vortex drag does not impose any limitation to the plane position (when the complete equation is used along with a large survey plane).

5.5.2 Lift
Maskell also developed a formulation to calculate lift based on wake surveys. He started from the momentum conservation equation of lift. Then he introduces the general Bernoulli equation (which accounts for the traverse velocity components) and the lifting line relationship between vorticity and circulation “Γ”:

\[
\xi dS = -d\Gamma
\] (62)

The lift momentum equation then reduces to:

\[
L = \int_{S_{\text{wake}}} \rho_0 U_0 y \xi dS + \int_{S_{\text{out}}} \rho_0 (U_0 - u) w dS
\] (63)

Where “\( S_{\text{wake}} \)” is the wake area at the survey plane. It can be seen that lift depends mainly on the axial vorticity created by the body (Usually the second term is neglected because it is very small compared to the first one). Epsilon allows calculating each term separately as well as the complete equation. The results are stored in 3 different variables, available in the Paraview’s drop-down list (detailed in Chapter 4).

5.6 Van Der Vooren method

In 1990 Van Der Vooren [4, 15, 16] has proposed to improve the typical approach by making an insight into the physics of the flow. In fact, he decided to deeply analyze the velocity deficit “\( \delta u \)” measured on the survey plane:

\[
\delta u = u - U_0
\] (64)

This deficit is split into two components: a first one (\( \delta \bar{u} \)) associated with the viscous and wave phenomena (which is zero outside the wake), and other one (\( \delta u^* \)) associated to an isentropic flow and the axial velocity variation due to the traverse flow field (a coupling), i.e.:

\[
\delta u = \delta \bar{u} + \delta u^*
\] (65)

With:
\[ \delta \bar{u} = U_0 \left( \sqrt{1 - \frac{2}{(y-1) M^2} \left( e^{\frac{(y-1) s}{M^2}} - 1 \right) + \frac{2 \delta h_t}{U_0^2} - 1} \right) \]  

(66)

Where “\( \delta h_t \)” is the specific total enthalpy variation respect to the upstream value and “\( M \)” the local Mach number. This approach allows writing the profile drag and the vortex drag as follows:

\[
D_p = -\int_{S_{\text{wake}}} \rho \ u \ \delta \bar{u} \ dS
\]

(67)

\[
D_v = -\int_{S_{\text{out}}} \left[ (P_s - P_{s0}) + \rho \ u \ (u - U_0 - \delta \bar{u}) \right] dS
\]

(68)

These equations are valid for incompressible and compressible regimes as well. It requires the existence of a Trefftz plane and that the flow remains isentropic and adiabatic between the survey plane and the Trefftz plane (So the survey plane cannot be placed between two bodies). Profile drag requires only a measurement on the wake region, nevertheless, the vortex drag requires data on the entire survey plane.

5.7 Giles method

In 1999 Giles [17] has developed a new formulation based on the simplified momentum conservation total drag equation, by using the definitions of stagnation enthalpy and entropy to replace the local axial velocity term of this equation, and by considering that the flow at the survey plane has no traverse component:

\[ \overline{U} = u \hat{i} + 0 \hat{j} + 0 \hat{k} \]

Then, after neglecting high-order terms he obtained:

\[
D_p = \int_{S_{\text{wake}}} \left( P_{s0} \frac{\delta s}{R} - \rho_0 \ \delta h_t \right) dS
\]

(69)

This expression is valid for compressible and incompressible flows as well, and it requires placing the survey plane on the Trefftz plane (i.e., far away from the body). It can be seen as an improvement of the Oswatitsch method because the “\( \delta h_t \)” term allows taking into account the power effects (i.e., thrust).

5.8 Kusunose method

In 2005 Kusunose [18] developed a new drag and lift formulations based on a small perturbations theory. He proposed to consider the perturbations of axial velocity, density and pressure:

\[
\begin{align*}
\left\{ 
 u &= U_0 + \delta u \\
 \rho &= \rho_0 + \delta \rho \\
 P_s &= P_{s0} + \delta P_s
\end{align*}
\]

(70)

5.8.1 Drag breakdown

After replacing the perturbation equations into the simplified total drag momentum equation and neglecting high-order terms, he obtained the expressions for the profile and vortex drag:

\[
D_p = \int_{S_{\text{wake}}} \left[ P_{s0} \frac{\delta s}{R} - \rho_0 \ \delta h_t - \frac{P_{s0}}{2} \left( \frac{\delta s}{R} \right)^2 + \rho_0 \ \delta h_t \left( \frac{\delta s}{R} - \frac{M_0^2 \ \delta h_t}{U_0^2} \right) \right] dS
\]

(71)
\[ D_v = \int_{S_{\text{wake}}} \frac{\rho_0 \psi \xi}{2} \, dS = \int_{S_{\text{out}}} \frac{\rho_0}{2} \left[ (v^2 + w^2) - (1 - M_0^2) \delta u^2 \right] dS \] (72)

This is valid for compressible and incompressible regimes. Even though it is based on small perturbations theory, it is highly accurate even for high-lift and strong shockwave flow cases. Also, note that this drag formulation is an improvement of the Giles method since it allows placing the survey plane closer to the body.

5.8.2 **Lift**

Proceeding in a similar fashion but with the momentum conservation equation for lift, he obtains:

\[ L = \int_{S_{\text{wake}}} \left[ \rho_0 U_0 \gamma \xi - \rho_0 U_0^2 (1 - M_0^2) \frac{w}{U_0} \left( \frac{u - U_0}{U_0} \right) + M_0^2 \frac{\gamma P_0}{R} \frac{w}{U_0} \delta s - \rho_0 M_0^2 \frac{w}{U_0} \delta h \right] dS \] (73)

Note that this expression is an improvement of the Maskell method since it takes into account the compressibility and power effects.

5.9 **Meheut method**

In 2006 Meheut [4] developed a combined approach by using a small perturbations method (As Kusunose) and by decomposing the axial velocity deficit (As Van Der Vooren), which leads to the following equation:

\[ D_p = \frac{\rho_0 u_0^2}{2} \int_{S_{\text{wake}}} \left[ -\frac{2}{\gamma M_0^2} \Delta P_t - \Delta T_t + \left( 1 - \frac{M_0^2}{4} \right) \Delta T t^2 - \Delta P_t \Delta T_t - \left( 1 - M_0^2 \right) \left( \Delta \delta u^2 + 2 \Delta u^* \Delta \delta u \right) \right] dS \] (74)

With:

\[
\begin{align*}
\Delta P_t &= \frac{P_t}{P_{t_0}} - 1 \\
\Delta T_t &= \frac{T_t}{T_{t_0}} - 1 \\
\Delta u &= \frac{u}{U_0} - 1 \\
\Delta u^* &= \sqrt{1 - \frac{2}{(\gamma - 1) M_0^2} \left( \frac{P_0}{P_{t_0}} \left( \frac{\gamma - 1}{\gamma} \right) - 1 \right) - \frac{v^2 + w^2}{U_0^2} - 1} \\
\Delta \delta u &= \Delta u - \Delta u^*
\end{align*}
\] (75-79)

This is valid for compressible and incompressible regimes as well, and its related error is of third order (smaller than Kusunose’s approach). In fact, it provides the most accurate profile drag value of all the far-field methods. It has also the advantage of reducing the measurement region to the wake. Nevertheless, its limitation is the survey plane position that cannot be placed closer than one chord to the body.

5.10 **Profile drag breakdown**

If there is no shockwave present in the flow field, the profile drag is equal to the viscous drag (the shockwave drag is zero). However, in the most general case, both components are present. Profile drag formulations already discussed do not allow separating the contribution of the wave drag and viscous drag. This can only be
achieved by first calculating the profile drag. Then, a physical reasoning introduced by Kusunose [19] is used. It proposes that the profile drag survey can be divided in 2 regions (see Figure 6):

- **Pure shockwave region**: some streamlines traverse only the shockwave (outside of the boundary layer), so they have low or zero vorticity at the survey plane as well as low drag density value (because shockwave losses are always small compared to viscous losses). With this physical criterion in mind, it is possible to extract this component.

- **Viscous region**: this is the part of the wake where streamlines come from the boundary layer. If a shock was present, this shock has affected also the streamlines in the viscous region (Boundary layer thickness). This region is characterized by high drag density value and high vorticity. According to Kusunose, the viscous region can be further split into a pure viscous and a SBLI (Shockwave-boundary layer interaction) parts, as shown in Fig. 6. It has been proposed to first extract its wave component by doing a hypothesis: the strength of the shockwave is considered constant across the boundary layer on each side of the body. If a body has the upper and lower shocks with different strength, it is assumed that the wave drag varies linearly between both extremes of the viscous wake. The rest of the viscous is then attributed to the pure viscous component. Note that this approach is well suited for single bodies like wings, but it may lead to questionable decompositions for complex geometries.

![Figure 6: profile drag breakdown by Kusunose method](image)

In Epsilon V2.0 the breakdown of the viscous region into its pure viscous and SBLI is not implemented because it has been shown to be impractical [20].

The far-field methods are well known for their limitation to analyze highly-coupled powered aircraft configurations. This is because those architectures do not allow a clean definition of drag and trust: the stream tube traversing the engine strongly interacts with the airframe. In order to provide an aerodynamic assessment for this kind of configurations, new methods have been developed (see the exergy section).
6 LAMB VECTOR METHODS

The Lamb vector method is an approach that generalizes the Kutta-Joukowsky theorem, which establishes a link between the lift force acting upon a body and the related circulation, i.e.:

\[ L = \rho V \Gamma \] (80)

Where “\( \Gamma \)” is the circulation, defined by:

\[ \Gamma = \oint \mathbf{V} \cdot d\mathbf{l} = \iint_{S} \mathbf{\omega} \cdot d\mathbf{S} = \iint_{S} (\nabla \times \mathbf{V}) \cdot d\mathbf{S} \] (81)

With “\( \mathbf{\omega} \)” the vorticity vector (a measure of the local rotationality of the flow). Hence, the circulation is a measure of the total rotationality of the flow field. Then, in a 2D case, lift can be thought of as the domain integral of the cross product between the upstream flow vector and the local vorticity vector.

\[ L = \rho \iint_{S} \mathbf{V} \times \mathbf{\omega} \, d\mathbf{S} \] (82)

This concept has been generalized in order to provide the total force acting upon a body either in 2D and 3D as follows:

6.1 Wu method

Wu was one the pioneers in the development of vorticity based formulations for the determination of the forces acting upon a body. In 2007 [21] he proposed using the Lamb vector to determine these forces:

\[ \mathbf{l} = \mathbf{\omega} \times \mathbf{V} \] (83)

Then, the lift, induced drag and profile drag are given by:

\[ L = -\rho \iiint_{V} l_z dv \] (84)

\[ D_i = -\rho \iiint_{V} l_x dv \] (85)

\[ D_p = -\rho \int_{S_{out}} \mathbf{x} \times (\mathbf{n} \times \mathbf{l}) \, d\mathbf{S} \] (86)

This is a CFD-based formulation because it requires knowing the vorticity field inside the entire boundary layer (something impossible to achieve in a wind tunnel testing). However, profile drag can be applied in both, CFD and wind tunnel cases because the Lamb vector is limited to the wake region.

6.2 Mele method

More recently, Mele [22] has improved the Wu’s formulation by including a compressibility correction term as follows, which leads to more accurate results:

\[ L = -\tilde{k} \iiint_{V} \rho l_z + m_p \, dv \] (87)
\[ D_i = -i \iiint_V \rho \lambda_X + m_{\rho} dv \]  
\[ D_p = -\rho \int_{S_{out}} x \times (n \times l) dS \]  

With:

\[ m_{\rho} = x \times \left[ \nabla \rho \times \mathbf{V} \left( \frac{V^2}{2} \right) \right] \]

Lamb Vector method is a powerful tool to understand physics from a very different point of view. Instead of regarding the surface tensions around the body surface (near-field) or the trace of the wake downstream of the body (far-field), it proposes to analyze the vorticity region surrounding the body (viscous region inside the boundary layer and wake). In fact, the vorticity contained inside the viscous region lead to the generation of forces that are perceived as lift, drag and sideforce.

### 7 EXERGY METHODS

This is a classical thermodynamic concept based on the 1\textsuperscript{st} and 2\textsuperscript{nd} laws of thermodynamics [23]. It decomposes the total energy of a system into two components: the exergy (the useful part of the energy) and the anergy (its useless part). The exergy concept states that any perturbation of the system (perturbation of speed, pressure, and so on) can be returned to its original (equilibrium) state by means of a reversible transformation (Carnot cycle). Hence, any perturbation has an inherent energetic potential (exergy) that can be converted to work by means of a reversible transformation. This can be expressed as follows:

\[ \varepsilon = \delta h_t - T_\infty \delta s \]  
\[ \mathcal{A} = T_\infty \delta s_{created} \]

Several authors have used this concept to evaluate the external aerodynamic behavior of flight vehicles. One of most recent formulations is that proposed by Arntz at ONERA.

#### 7.1 Arntz method

In 2014, Arntz [24] developed an exergy formulation well suited for the analysis of CFD simulations. It is given by:

\[ \dot{\varepsilon}_{\text{prop}} + \dot{\varepsilon}_q = W \dot{\Gamma} + \dot{\varepsilon}_m + \dot{\varepsilon}_{th} + \dot{\mathcal{A}}_\Phi + \dot{\mathcal{A}}_{\text{VT}} + \dot{\mathcal{A}}_w \]

In Epsilon V2.0 only unpowered adiabatic cases have been considered (i.e., \( \dot{\varepsilon}_{\text{prop}} = 0 \) and \( \dot{\varepsilon}_q = 0 \)) and then this expression can be rewritten to obtain the exergy-based drag as follows:

\[ D_\varepsilon = \dot{\varepsilon}_m + \dot{\varepsilon}_{th} + \dot{\mathcal{A}}_\Phi + \dot{\mathcal{A}}_{\text{VT}} + \dot{\mathcal{A}}_w \]

This drag value is absolutely comparable with the drag prediction methods discussed before and it also allows a more comprehensive drag breakdown [20]. In this expression, \( \dot{\varepsilon}_m \) is the outflow of mechanical exergy across
the survey plane, “\(\dot{e}_m\)” is the thermal exergy outflow, “\(\dot{\mathcal{A}}_f\)” the viscous anergy created inside the control volume, “\(\dot{\mathcal{A}}_r\)” the thermal anergy and « \(\mathcal{A}_w\) » the shockwave anergy. Each term represent an equation itself as indicated as follows:

\[
\dot{e}_m = \int_{\text{Sout}} \frac{1}{2} \rho \delta u^2 (\bar{V}, \bar{n}) dS + \int_{\text{Sout}} \frac{1}{2} \rho (v^2 + w^2)(\bar{V}, \bar{n}) dS + \int_{\text{Sout}} (P_s - P_0)(\bar{V} - \bar{V}_0) \cdot \bar{n} dS = (\dot{e}_m = \dot{E}_u + \dot{E}_v + \dot{E}_p) \tag{95}
\]

\[
\dot{e}_{th} = \int_{\text{Sout}} \rho \delta e (\bar{V}, \bar{n}) dS + \int_{\text{Sout}} P_s (\bar{V}, \bar{n}) dS - T_s \int_{\text{Sout}} \rho \delta s (\bar{V}, \bar{n}) dS \tag{97}
\]

\[
(\dot{e}_{th} = \dot{E}_{th} + \dot{E}_w + \dot{\mathcal{A}}) \tag{98}
\]

\[
\dot{\mathcal{A}} = \int_v \frac{T_s}{T_x} \phi_{\text{eff}} dv \tag{99}
\]

\[
\dot{\mathcal{A}}_r = \int_v \frac{T_s}{T_x} k_{\text{eff}} (\bar{V} T)^2 dv \tag{100}
\]

\[
\dot{\mathcal{A}}_w = T_s \int_{\text{wave}} (\rho \delta s \bar{V}). \bar{n} \; dS_{\text{wave}} \tag{101}
\]

Where “\(\delta s\)” is the specific total variation of entropy respect to the upstream condition (equilibrium condition), “\(k_{\text{eff}}\)” is the effective thermal conductivity and “\(\phi_{\text{eff}}\)” is the effective dissipation. These two terms are given by:

\[
\kappa_{\text{eff}} = c_p \left( \left( \frac{\mu}{\rho V} \right) + \left( \frac{\mu_{\text{turb}}}{Pr} \right) \right) \tag{102}
\]

\[
\Phi = (\bar{V}, \bar{V}) \tag{103}
\]

\[
\mu_{\text{eff}} = \mu + \mu_t \tag{104}
\]

\[
\phi_{\text{eff}} = \mu_{\text{eff}} \left\{ 2 \left( \frac{\partial u}{\partial x} \right)^2 + 2 \left( \frac{\partial v}{\partial y} \right)^2 + 2 \left( \frac{\partial w}{\partial z} \right)^2 + \left( \frac{\partial u}{\partial y} + \frac{\partial v}{\partial x} \right)^2 + \left( \frac{\partial u}{\partial z} + \frac{\partial w}{\partial x} \right)^2 + \left( \frac{\partial v}{\partial z} + \frac{\partial w}{\partial y} \right)^2 \right\} - \frac{2}{3} \mu \left( \frac{\partial u}{\partial x} + \frac{\partial v}{\partial y} + \frac{\partial w}{\partial z} \right)^2 \tag{105}
\]

Where “\(\mu\)” is the laminar viscosity, “\(\mu_t\)” is the turbulent viscosity and “\(Pr\)” the Prandtl number.

One of the advantages of the exergy approach is that it takes into account the viscous term of the momentum equation during its formulation developing. So, it allows placing the survey plane everywhere. All the far-field formulations discussed before cannot accept a survey plane placed very close to the body, simply because the stress tensor influence has been ignored. Another advantage is its validity for both, incompressible and compressible flow. Also, this method provides a very accurate drag prediction.

### 7.1.1 Wave anergy

An alternative expression for the wave anergy can be obtained by using the Gauss theorem, in order to convert the surface integral into a volume integral:

\[
\dot{\mathcal{A}}_w = \int_{V_{\text{vol}}} \bar{V}. (T_s \rho \delta s \bar{V}) \; dV_{\text{vol}} \tag{106}
\]

Where “\(V_{\text{vol}}\)” is the shockwave volume.
7.1.2 Total anergy
The total anergy is given by the sum of the anergy terms:

$$\sum A = A_F + A_{PT} + A_W$$  \hspace{1cm} (107)

However, it was reported by Arntz that this sum does not give the real total anergy when the equations are implemented on a CFD post-treatment code because of numerical errors (due to the integration of high-order derivatives). Thus, an accurate way to obtain the total anergy “$A$” is by using the following equation:

$$A = T_S \int_{S_{out}} \rho \delta s \left( \vec{V} \cdot \vec{n} \right) dS$$  \hspace{1cm} (108)

This requires a surface integration on the survey plane only, thus it gives a highly accurate total anergy value.

7.1.3 Thermal exergy
An alternative expression for $\dot{\varepsilon}_{th}$ is given by [24]:

$$\dot{\varepsilon}_{th} = \dot{\varepsilon}_{th, temperature} + \dot{\varepsilon}_{th, pressure}$$  \hspace{1cm} (109)

With:

$$\dot{\varepsilon}_{th, temperature} = \int_{S_{out}} \rho c_v T_S \left[ 1 - \frac{T_S}{T_s} \ln \left( \frac{T_S}{T_s} \right) \right] dS - \int_{S_{out}} \rho c_v T_{S_0} \left( \vec{V} \cdot \vec{n} \right) dS$$  \hspace{1cm} (110)

$$\dot{\varepsilon}_{th, pressure} = \int_{S_{out}} P_{S_0} \left[ 1 - \frac{\rho}{\rho_0} \ln \left( \frac{\rho}{\rho_0} \right) \right] \left( \vec{V} \cdot \vec{n} \right) dS - \int_{S_{out}} P R T_{S_0} \left( \vec{V} \cdot \vec{n} \right) dS$$  \hspace{1cm} (111)

This is the actual formulation used in Epsilon because it only requires data on the survey plane.

7.1.4 Exergy flow field interpretation
The physical interpretation of the exergy parameters is not provided in this manual, but it can be found in detail in [25, 26] as well as in the Epsilon website:


7.2 Aguirre method
Since 2018, ISAE is working on the improvement of the original exergy method proposed by Arntz. The first stage was the modification of the exergy method in order to adapt it for wind tunnel testing. The new resulting formulations and methods are coded into Epsilon as described below:

7.2.1 Wave anergy (volume formulation)
The volumetric formulation of the wave anergy (Eq. 101) poses the challenge to properly limit the integral region. The original approach proposed by Arntz was to use the Lovely and Haines shockwave detector (see next section) to identify the shockwave region. An alternative approach [31] is to use the Q-criterion (see next section) to take away the viscous region from the volume integral. This simplifies the integration task as it will be explained in Chapters 4 and 5.
7.2.2 Wave anergy (wake surface formulation)
The wave anergy extraction method proposed by Arntz requires performing a volume integral or a surface integral around the shockwave volume. This approach is not feasible for wind tunnel testing, thus an adaptation of the Kusunose drag breakdown was developed. The new method [20, 31] analyzes the total anergy distribution on a survey plane as shown in Figure 7.

![Wave anergy](image)

**Figure 7: total anergy breakdown**

Then, the part of its distribution lying outside the viscous wake corresponds to the wave anergy losses. This allows the extraction of the wave anergy from the total anergy distribution. The remaining part of the distribution is a mixing of thermal and viscous anergy created inside the boundary layer and the wake.

This total anergy breakdown method is included in the same Epsilon module as the Kusunose breakdown method (it will be detailed in Chapter 4).

7.2.3 Redefinition of the mechanical and thermal exergy (infinite surface formulation)
Some inconsistencies have been identified in the original exergy formulation as discussed in [29]. This led to a redefinition of the mechanical and thermal exergies through the reformulation of the boundary pressure work rate:

\[
\dot{E}_p^{\text{new}} = \dot{E}_p^{\text{Arntz}} + \dot{\varepsilon}_{\text{th pressure}} \\
\dot{\varepsilon}_{\text{th new}} = \dot{\varepsilon}_{\text{th temperature}}
\]

(112)

(113)

Hereafter, the Arntz equations with the modifications indicated here will be called “redefined Arntz equations”. These are still infinite surface formulations (as the Artnz equations), hence, only suited for CFD analysis.

7.2.4 Profile drag
Recently, the redefined Arntz’s equations have been used as the starting point to develop a new formulation suited for measuring exergy in a wind tunnel testing (WTT) [27-31]. The objective of the wind-tunnel method (also called “WTT-method”) is to reduce the infinite surface integral required by the Arntz’s method to the wake region. This is achieved by using the velocity decomposition technique [28, 30] that splits a velocity component into its isentropic (\( u^* \)) and non-isentropic (\( \overline{u} \)) parts:

\[
u = u^* + \overline{u}
\]

(114)
The non-isentropic velocity is the part of the velocity field that is related to the losses (viscous or wave losses), whereas the isentropic velocity gives the equivalent of a potential flow field (where no losses occur). The magnitude of this isentropic velocity is given by:

\[ V^* = u_0 \sqrt{1 - \frac{2}{(y-1) M_0^2 \left( \frac{p_t}{p_0} \right)^{\frac{y-1}{y}}} \left( \zeta - 1 \right)} \] (117)

With:

\[ \zeta = 1 + \frac{y-1}{2} M_0^2 \left( 1 - \frac{V^*}{u_0} \right)^2 \] (118)

In the same fashion, the temperature and density can be also splitted into its isentropic and non-isentropic components as follows:

\[ T_s = T_s^* + \tilde{T}_s \] (119)
\[ \rho = \rho^* + \tilde{\rho} \] (120)

With:

\[ T_s^* = T_{s,0} \left[ 1 + \frac{y-1}{2} M_0^2 \left( 1 - \frac{V^*}{u_0} \right)^2 \right] \] (121)
\[ \rho^* = \rho_0 \left[ 1 + \frac{y-1}{2} M_0^2 \left( 1 - \frac{V^*}{u_0} \right)^2 \right]^{\frac{1}{y-1}} \] (122)

Then, by replacing the “\( u, v, w, \rho \) and \( T_s \)” terms of the redefined Arntz equations by their isentropic version \((\cdot)^*\), the isentropic drag and exergies can be obtained (See Ref. [30] for further details). This finally leads to the determination of the non-isentropic drag and exergies as follows:

\[ \overline{C_{D_e}} = C_{D_e} - C_{D_e}^* \] (123)
\[ \overline{\dot{E}_m} = \dot{E}_m - \dot{E}_m^* \] (124)
\[ \overline{\dot{E}_u} = \dot{E}_u - \dot{E}_u^* \] (125)
\[ \overline{\dot{E}_v} = \dot{E}_v - \dot{E}_v^* \] (126)
\[ \overline{\dot{E}_p} = \dot{E}_p - \dot{E}_p^* \] (127)
\[ \overline{\dot{E}_{th}} = \dot{E}_{th} - \dot{E}_{th}^* \] (128)

The idea behind this decomposition method is that the non-isentropic components are reduced to the wake region and physically related to the profile drag generation (viscous and wave losses). The isentropic
components are equivalent to a **potential flow** (where no losses occur), thus, they do not intervene in the generation of drag. Hence, the determination of drag by the WTT-method only requires a wake integral of the non-isentropic terms (whereas the CFD-based method requires the knowledge of aerodynamic parameters on an infinite survey plane).

### 7.2.5 Profile drag correction

The WTT method presented before has proven to perform well for survey planes placed at least at 0.5 chords downstream of the trailing edge of a body [30]. If the survey plane gets closer to the body, a correction accounting for the isentropic coupling must be introduced [28] as follows:

\[
\overline{C_D}_{\text{corrected}} = \int_{S_w} \left( \overline{C_D} + |\overline{C_D}|_{\text{wake}} \right) dS
\]

\[
\overline{E_m}_{\text{corrected}} = \int_{S_w} \left( \overline{E_m} + |\overline{E_m}|_{\text{wake}} \right) dS
\]

### 7.2.6 Vortex exergy (induced drag)

The vortex exergy (transverse exergy) formulation proposed by Arntz requires performing an integration on the entire survey plane, which is not suited for wind tunnel testing. Thus a new formulation was provided in order to limit the integration to the wake region only [27] by combining the Maskell method with the velocity decomposition method as follows:

\[
\overline{E_v} = \int_{S_{\text{wake}}} \frac{1}{2} \rho (\psi - \Phi \sigma) u^* dS
\]

\[
u^* = U_0 \sqrt{1 - \frac{2}{(\gamma - 1)M_0^2} \left( \frac{P_x}{P_{x0}} \right)^{\frac{\gamma - 1}{\gamma}} - 1 - \frac{(\psi - \Phi \sigma)}{U_0^2}}
\]

\[
\zeta = 1 + \frac{\gamma - 1}{2} M_0^2 \left( 1 - \frac{u^2 + \psi - \Phi \sigma}{U_0^2} \right) \frac{T_{x0}}{T_e}
\]

This formulation has proven to provide **more accurate induced drag values** than the Maskell method.

### 8 CLASSICAL ANALYSIS METHODS

Epsilon also provides some useful parameters to perform classical aerodynamic analysis:

#### 8.1 Shockwave detection

The shockwave surface can be detected by using the Lovely and Haines criterion [32]:

\[
\text{ShockDetector} = \frac{\overline{\nabla \overline{P} \overline{s}}}{a |\overline{P} \overline{s}|} \geq 0.95
\]

Where “\(\overline{\nabla \overline{P} \overline{s}}\)” is the pressure gradient.

#### 8.2 Vortex detection

A vortex can be detected by several methods. In Epsilon V2.0, there are two of the most used methods:
8.2.1 Q-criterion
The Q-criterion is based on the magnitudes of the vorticity \( \omega \) and strain rate \( S \) to identify the vortex region as follows:

\[
Q = \frac{1}{2} (\omega^2 - S^2) \geq 0
\]  
(135)

8.2.2 Lambda 2 criterion
According to this criterion, a vortex exists in regions where is negative the second eigenvalue \( \lambda_2 \) of the following equation, where \( J \) is the velocity gradient:

\[
S^2 + (J - S)^2
\]  
(136)

8.3 Wake detection

8.3.1 Total pressure ratio
The wake region can be detected by several methods. The most used is the total pressure ratio:

\[
\frac{P_s}{P_{c0}} < 1
\]  
(137)

9 NONDIMENSIONALIZATION

The lift and drag equations previously discussed are dimensionalized. It is much more practical to work with lift and drag coefficients \( C_L \) and \( C_D \) respectively, defined as follows:

\[
C_L = \frac{L}{\frac{1}{2} \rho_0 U_0^2 S_{ref}}
\]  
(138)

\[
C_y = \frac{F_y}{\frac{1}{2} \rho_0 U_0^2 S_{ref}}
\]  
(139)

\[
C_D = \frac{D}{\frac{1}{2} \rho_0 U_0^2 S_{ref}}
\]  
(140)

Where \( S_{ref} \) is a reference surface (the airfoil chord for 2D cases or wing plan surface for 3D cases). In a similar fashion, it is defined the anergy and exergy coefficients (expression valid also for its components) and the exergy-based drag coefficient:

\[
C_{\dot{A}} = \frac{\dot{A}}{\frac{1}{2} \rho_0 U_0^2 S_{ref}}
\]  
(141)

\[
C_{\dot{E}} = \frac{\dot{E}}{\frac{1}{2} \rho_0 U_0^2 S_{ref}}
\]  
(142)

\[
C_{D_{\dot{E}}} = \frac{\dot{E}_m + \dot{E}_h + \dot{A}_\Phi + \dot{A}_T + \dot{A}_w}{\frac{1}{2} \rho_0 U_0^2 S_{ref}}
\]  
(143)

The denominator used to non-dimensionalize the previous equations will be available as a separate variable:
Moreover, the pressure will be non-dimensionalized in order to obtain the pressure coefficient:

\[ C_p = \frac{P_s - P_{s0}}{\frac{1}{2} \rho_0 U_0^3} \]  

(146)
CHAPTER 2: THE ARCHITECTURE OF EPSILON

This chapter details the architecture of Epsilon and the functionalities of Paraview. The programmable sources and filters with a custom-made GUI are explained here. Chapters 3 and 4 will explain in detail how to use those tools in practice.

It is advised to have some background knowledge of Paraview before starting using Epsilon. A recommended lecture is available in references [33,34]. Hereafter we will consider that the Epsilon user is already familiarized with the CFD posttreatment in Paraview.

1 ARCHITECTURE

Epsilon is set of filters and plugins created for the analysis of 2D and 3D steady state CFD simulations and experimental data (WTT). Its architecture is very simple as it can be seen in Figure 8:

It consists of 5 stages. Firstly, the user must load its CFD or experimental data into Paraview. Then all the near-field, far-field, Lamb vector and exergy equations are implemented in a Python code called “Epsilon_Aero_Data”. This allows the visualization and analysis of these aerodynamics parameters on the entire field by using the standard Paraview tools. Moreover, a special integration tool was included in order to study several survey plane positions automatically. Finally, some particular near-field, far-field and exergetic methods are computed by separated modules due to the related complexity.

2 INPUT DATA

2.1 Data formats

Epsilon supports any type of aerodynamic data either computational or experimental data, provided that these formats are readable by Paraview.
2.1.1 CFD data
Several commercial CFD solvers are supported by Epsilon by default (non-exhaustive list):

- Fluent
- STAR CCM+
- elsA
- Open Foam

CFD data from other solvers can be easily read by writing a small Python script (see “Readers files” section). CFD data is simply loaded into Paraview and then it is possible to apply the Epsilon custom filters.

2.1.2 Wind Tunnel data
Experimental data can also be analyzed with Epsilon: PIV (2D2C, stereo and 3D) as well as directional probes (five-hole probe and seven-hole probe). This kind of data is loaded indirectly by using a custom source called “Epsilon Wind Tunnel”. It is a Python programmable source that reads the measurement CSV file and creates a delaunay2D mesh plane containing all the measured variables (pressures and velocity components). The CSV file must respect the following headers designation: X, Y, Z, Vx, Vy, Vz, Pt, Ps (Pt and Ps are present only in multi-hole probe data). Moreover, the XYZ-coordinates of the CSV measurement data must be coincident with the aerodynamic reference frame (The user must arrange the headers if needed prior to open it with Epsilon). Details about this source will be covered by a specific video tutorial in the Epsilon website.

IMPORTANT: please, keep in mind that Epsilon Wind Tunnel is still in development/validation phase. Moreover, the actual version of Epsilon (V2.0) do not calculate the static pressure field from the PIV data. Thus, the user must ignore any Epsilon Aero Data parameter requiring Ps in its formulation (see below).

2.2 Readers files
These are auxiliary Python files executed by the main Epsilon python code (Epsilon Aero Data). The readers load the incoming CFD or experimental data arrays and calculate some missing parameters. Its output always contains the following variables: POINTS, Vx, Vy, Vz, Ps, Ts, Rho, MU_LAM, MU_TURB, MU_EFF, Keff. These are the only required variables to properly execute Epsilon Aero Data. Hence, the input CFD data must provide those variables or at least it should be possible to compute a missing variable from the existing data.

Epsilon V2.0 is released with readers of some CFD softwares. Other CFD codes may be used with Epsilon, provided that the user develops an appropriate reader file by replicating the examples already provided.

3 EPSILON AERO DATA
At this point we are ready to use the CFD/WTT data loaded into Paraview in order to implement the equations presented in the previous chapter. This will be made by using the so called “Programmable Filters”.

3.1 Paraview’s programmable filters
In Paraview, the programmable filters are a way to process data inside the Paraview Server by a Python code provided by the user, and then to display it on the Paraview Client. The user can also create a custom GUI to
display and control the input parameters of the Python code. This is made by a Server Manager Configuration file (XML file).

3.1.1 The Python code

The python code can be either coded in a dedicated window on Paraview, or even better, executed from an external Python file. This Python file contains the code that reads the existing aerodynamic parameters at each point of the mesh in Paraview. Then it determines the new near-field, far-field, Lamb vector and exergy aerodynamic parameters at each point. This data is stored in several new arrays that are sent to the Paraview Server and displayed in the Paraview client.

The Python file is called “Epsilon_Aero_Data.py” and is fully commented to help the understanding of the code. By the way, it is worth to note that this file can be easily modified by users in order to implement some improvements (to add new formulations for example). For normal purposes, this file is ready to use and should not be modified.

3.1.2 The XML file

In order to create a custom-made GUI showing all the inputs of the Python code to play with, a XML file must be used. This file is called “Epsilon_Aero_Data.xml” and contains information about the type of filter to be created (programmable filter), the file path to the Python code to be executed, the input parameters, its default values and the way they are displayed in the GUI.

3.1.3 Paraview’s plugin

When this XML file is loaded into Paraview, it creates a new filter icon called “Epsilon Aero Data”. If the user clicks on it, this will execute the XML file which creates the GUI and executes the associated Python file. The resulting output arrays are displayed on the screen. So, for the final user, an easy to use aerodynamic calculator is available (it provides the near-field, far-field, Lamb vector and exergy parameters). An advanced user can also improve its capabilities by slightly modifying the XML or Python files.

In a general way, whenever a custom filter is needed, a Python code and a XML file with the same name are created and loaded into Paraview. This approach has been used extensively on Epsilon.

3.2 Epsilon Aero Data Code

This is the Python file mentioned above and is the brain of the entire Epsilon code. It is here where most of the aerodynamic equations are introduced. It is basically composed of 4 stages:

First of all, it reads the existing CFD/WTT data already loaded into Paraview. This is achieved by calling the reader file (Python codes) that suits the input format. This allows converting the input data arrays from the Paraview format into a Python readable format.

The second step is to rotate the vector data. As it was stated in Chapter 1, Epsilon uses the aerodynamic reference frame, which is not always coincident with the mesh reference frame. Hence, a transformation of some data arrays is required (i.e., the vectors and tensors) based on the angle of attack and sideslip angles.

The third step is to implement the formulations. Since all formulations are integral, Epsilon Aero Data just implements the integrands of those equations. The integration procedure is left to be applied later. Thus, Epsilon Aero Data will evaluate the integrand of the equations from Chapter 1 at each point of the mesh. Some equations have integrands composed by several terms. In some of those cases, an evaluation is made for each
term at every mesh point. This decomposition is particularly useful while studying the influence of its terms in a given result.

The fourth and final step is to send all these new data arrays to the Paraview server in order to be shown on the Paraview Client. At the end of this process, Epsilon Aero Data creates several data arrays that will be available for the user. The list of arrays names and its corresponding equations are detailed in the Appendix 1.

4 DATA VISUALIZATION AND INTEGRATION

Once the Epsilon Aero Data filter has been applied, the user is ready to visualize and analyze the aerodynamic parameters (i.e., near-field, far-field, Lamb vector and exergy).

4.1 Epsilon Axes

Since the mesh axes are not always coincident with the aerodynamic axes, it may be confusing for the user to interpret the aerodynamic data (evaluated in the wind axes) by using the mesh reference axes. That’s why a Programmable filter is provided (“Epsilon Axes”), which allows drawing the aerodynamic axes on the screen as shown in Figure 9. This is a practical tool for a beginner user (Once the user gets familiarized with Epsilon, it is no longer needed).

4.2 Field visualization

At this stage, the user can profit from the standard Paraview filters in order to visualize data as usual. The Epsilon Aero Data output do not allow to detect automatically the body geometry, so this surface must be extracted first (The step-by-step procedure is explained in Chapters 4 and 5). Once made, the surface can be colored by the typical parameters (i.e., pressure coefficient) but also by the new aerodynamic parameters. This color data visualization can also be made on slices across the data volume in order to see the field parameters. In particular, it is interesting to use a plane normal to the upstream flow direction because all the formulations consider such a survey plane. In fact, when the user executes Epsilon Aero Data, it displays in the Paraview messages window the components of the normal surface vector. This information must be used to set up the proper survey plane inclination.

Epsilon Aero Data also provides a velocity vector field, thus the user can directly employ the SurfaceLIC filter in order to analyze the surface flow pattern (Figure 9). This can be applied to the body surface and the slice plane as well. Other important tools are the streamlines tracer and iso-surface plots. They can be used as usual to analyze the new aerodynamic parameters. Details on these tools are available in the Paraview manual.

![Figure 9: data visualization example](image)
4.3 Integration of the equations

Epsilon Aero Data evaluates the integrand of the aerodynamic analysis methods at every mesh point. This allows visualizing the **density of drag**, density of lift, and so on. However, the major goal is to obtain drag, lift, exergy and anergy values already integrated. This is achieved by following two approaches:

4.3.1 Surface integrals

The majority of the equations presented in the Chapter 1 require to be integrated on the survey plane (and sometimes this integral is reduced to the wake region of this survey plane). For those cases, it is just necessary to place a slice plane normal to the upstream flow direction, and to set the desired axial position as seen on Figure 10-left. This will allow obtaining the values of the equations integrands at the entire slice plane. Thus, it just requires applying the standard “Integrate variables” filter to the plane data. Its output is a table with one row and one column for each parameter. In each cell it is shown the integrated value of each parameter.

**Important**: Note that only the parameters requiring a surface integral must be taken into account in this output table. For example, the integral of the “BETZ_profile_drag” density gives the profile drag value. However, the integrals of some anergy parameters (demanding a volume integration in its formulae) are **meaningless**. Thus, the user MUST always be conscious of the equations discussed in Chapter 1.

4.3.2 Volume integrals

Some anergy and Lamb vector equations require integrating data inside the control volume (Figure 10-right). In this case the “Integrate variables” filter can be applied directly to the Epsilon Aero Data output.

As before, the output table with the integrated data must be analyzed carefully. The user MUST only observe the anergy and Lamb vector terms requiring volume integration. All the remaining volume integrated parameters are **meaningless**. An intermediate solution to the problem is to apply the “Pass Arrays” filter to Epsilon Aero Data in order to retain only the formulations requiring a volume integral and then to integrate the output of this “Pass Arrays” filter. However, the **simplest solution is to use Epsilon Integration Tool** since all these interpretation issues are solved.
5  EPSILON INTEGRATION TOOL

5.1  The conceptual approach

The integration technique already presented allows the user to know the integrated parameters for a certain survey plane position. For most of applications this is enough. However, sometimes it is useful to sweep this survey plane and to integrate the parameter’s values at each plane position in order to evaluate aerodynamic parameters dependency with plane position (For example, to evaluate the profile drag vs the plane position downstream of a body, or to obtain the lift and drag distribution along the wing span). This is achieved with Epsilon Integration Tool.

5.2  Line distribution

This tool option allows animating the survey plane position: the idea is to place the survey plane at several positions and to store the integrated values at each position in a vtk polyline output. This vtk polyline is in fact formed by several points as shown in Figure 11. These points are used to define the survey plane positions (this plane is always placed normal to the upstream flow direction). Then, by following an iterative approach, the plane is placed at each point and its data is integrated and stored as point data.

![Figure 11: integrated x-, y-, z-coordinates for several 2D and 3D survey planes positions](image)

The resulting polyline data can then be visualized in several ways. The simplest way is to WarpByScalar the integrated values as shown in Fig. 12:

![Figure 12: vtkPolyline data warped by ARNTZ_A along the mesh Y-axis](image)
5.3 3D to 2D mapping

One of the major functionalities provided by Epsilon Integration Tool is its ability to integrate a 3D volume data into a plane as shown in Figure 13.

Thus, each point of this plane represents the local integral of the 3D domain along the survey line. This is achieved by creating a survey line traversing the entire 3D domain, placed normal to the upstream flow direction (because the integrated far-field and exergy values are only meaningful if the survey plane is normal to the upstream direction). This line is obtained by the intersection of 2 planes: the survey plane and a plane parallel to the x- and z-axes (called “intersection plane”).

This survey line then is iteratively placed at each point of a user defined plane mesh and then data is integrated along the line. Hence, the integrated data is stored at each point of the mesh.

6 COMPLEMENTARY METHODS

Some of the formulae discussed in Chapter 1 cannot be directly implemented in Epsilon Aero Data because of its complexity. That is why they are treated separately.

6.1 Epsilon Near-Field

The near-field method requires knowing some body surface parameters like the surface normal vectors. This requires first to extract the body surface data from the hole field data and then to execute Epsilon Near Field. This filter computes the normal vectors and wall shear stress at each surface point, leading to the calculation of the near field lift, drag and moments.

6.2 Epsilon Profile Drag Breakdown

This filter allows performing a profile drag breakdown into viscous and wave drag, based on Kusunose and Aguirre approaches. Both methods start from the drag density field of some parameter provided by Epsilon
Aero Data (e.g., MEHEUT_profile_drag). This field is then decomposed following different criteria to split the domain: the Kusunose method relies on the vorticity field whereas the Aguirre method relies on the viscous anergy generation field.

6.3 Epsilon Poisson Solver

The vortex drag calculation based on the Maskell and Aguirre methods requires the determination of the stream function and the potential function on the survey plane. This is provided by the Epsilon Poisson Solver custom filter. It first reads a planar wake data: it could be a slice of the 3D CFD flow field or the actual wake data obtained in a WTT. Then it solves the Poisson equation by using Green functions. Finally, it calculates the induced drag and vortex exergy parameters.
CHAPTER 3: INSTALLATION PROCEDURE

1 DISCLAIMER

Epsilon V2.0 was developed for Paraview versions with Python 2.7. It will not work in Paraview versions with Python 3.

2 EPSILON DOWNLOAD

Download the latest Epsilon version here: https://websites.isae-supaero.fr/epsilon-exergy-analysis-tool/download/

3 EPSILON INSTALLATION

The installation procedure just requires 4 steps:

- Place XML files and Python files in the desired folder
- Update the Python file path indicated in the XML files
- Load the plugins in Paraview
- Restart Paraview

Those steps are detailed below.

3.1 Files organization

If you have administrator rights, it is advisable to place all the files (XML and Python) in the Paraview installation folder or directly on the disk C. If you don’t have administrator rights, you can place the files elsewhere but, once the plugin is successfully installed, they must not be removed.

3.2 File path definition

If the installation folder is not “C:/EPSILON/”, all the XML files must be slightly edited: they must be opened with a text editor and the Python file path must be updated. The modifications to do are detailed in Table 2.

The best and quick way to edit all the files at the same time in a single step is to use a TXT editor (e.g., Notepad++), which allows replacing the file paths very easily with his “Search and replace” tool.

It is also possible to modify this path by hand before loading the plugins, by using the GUI displayed on Paraview’s screen when the filter is executed. So, there is an alternative way to set up the file path directly on Paraview but the first method is recommended.
3.3 Loading the plugins

Open Paraview and follow these steps:

Tools → Manage Plugins... → Load New → Files of type: select XML type
   → Search and Open XML file
   → Activate “Auto Load”

A legend with the name of the plugin will appear in the plugins list name and its property status must be “loaded”. Otherwise, an error message will pop-out and the status will be “Not Loaded”.

If the user wants to automatically load this plugin every time Paraview is opened, the “Auto Load” option must be selected. Click on the triangle placed at the left of the plugin name. This will drop-down advanced options. Then activate the option “Auto Load” and close.

Besides the Epsilon plugins, the user must also activate the “SurfaceLIC” standard Paraview plugin.

3.4 Reset session

The final step is to reset the session. This allows to restart Paraview properly and avoiding any error in the installation procedure.

Edit → Reset session

Now just close Paraview and open it again: you are ready to perform an aerodynamic analysis with Epsilon.
CHAPTER 4: ANALYSIS OF 2D CFD DATA

In order to simplify the usage of Epsilon, its use can be divided in two cases: 2D and 3D applications. The main Epsilon functionalities will be explained for the 2D case but they are valid for 3D cases as well.

1 PROCEDURE

The list of recommended actions for the analysis of 2D cases is detailed in Figure 14:

![Figure 14: setup procedure for 2D cases](image)

(•) Only for grid adaption cases
(••) Optional
(•••) Paraview analysis = Plot On Intersection Curves
(••••) Only for 2D planar mesh (e.g., Fluent)

2 PREVIOUS CONSIDERATIONS

It is NOT recommended to activate the “Auto Apply” option because it may lead to unattended actions that require a lot of time to be executed. Instead, it is recommended that the user confirms every action (The confirmation is made by clicking on the “Apply” button every time an action is demanded).

3 LOADING CFD/WTT DATA

The first stage is to load the data into Paraview. The procedure change slightly depending on the type of file to read:
3.1 Experimental data

Sources → EPSILON → Epsilon Wind Tunnel → Define CSV file path
→ Select instrument type
→ Select survey plane alignment
→ Define origin position (if needed)
→ Apply

The name of the variables contained in the file must be the followings: X, Y, Z, Vx, Vy, Vz, Ps and Pt

3.2 Fluent CAS files

File → Open → Select .cas Fluent file
→ Open data with → Fluent Case Files → Ok

The name of the variables contained in the file must be the followings: X_VELOCITY, Y_VELOCITY, Z_VELOCITY, PRESSURE, DENSITY, TEMPERATURE, MU_LAM and MU_TURB.

3.3 Fluent CGNS files

File → Open → Select .CGNS Fluent file
→ “Properties” tab → Select all the “Points Array”

The name of the variables contained in the file must be the followings: Velocity, Pressure, Density, Temperature, ViscosityMolecular and ViscosityEddy.

It is advisable to check if the CGNS file was well loaded into Paraview by plotting the “dV_dX” array. It must provide a reasonable variation around the body. If the CGNS was not well generated in Fluent, a weird distribution of “dV_dX” will displayed, especially towards the far field boundary. In this case, it is necessary to create again the CGNS file in Fluent.

3.4 Fluent Ensight Gold Case files

File → Open → Select .encas file
→ Open data with → Ensight Files → Ok

The name of the variables contained in the file must be the followings: x_velocity, y_velocity, z_velocity, pressure, density, temperature, viscosity_lam and viscosity_turb.

Note: the user may want to apply “Extract Block” filter in order to retain only the fluid region and discard the mesh lines (internal_fluid) that annoys the visualization.

3.5 Open Foam files

File → Open → Files of type → All files → Select .OpenFOAM file
→ Open data with → OpenFOAM → Ok
For single a block mesh, let the properties panel by default an Apply. However, for multiblock mesh cases, select:
Case type → Decomposed Case

The name of the variables contained in the file must be the followings: U, p, t and nut.

### 3.6 STAR CCM Ensight Gold Case files

File → Open → Select .case file → OK

The name of the variables contained in the file must be the followings: Velocityi, Velocityj, Velocityk, AbsolutePressure (or StaticPressure), Density, Temperature (or StaticTemperature), TurbulentViscosity and TurbulentViscosityRatio (or EffectiveViscosity).

### 3.7 elsA Tecplot files

File → Open → Files of type → All files → Select solutionXXXX file → OK
→ Open data with Tecplot Binary Files (Visit) → OK

The name of the variables contained in the file must be the followings: ro, rovx, rovy, rovz, roE, rok and roeps.

### 3.8 elsA CGNS files

File → Open → Select .CGNS file
→ “Properties” tab → Select all the “Points Array”

The name of the variables contained in the file must be the followings: Density, Momentum, Pressure, Temperature and Viscosity_EddyMolecularRatio.

### 3.9 TAU Tecplot files

File → Open → Files of type → All files → Select .plt file → OK
→ Open data with Tecplot Binary Files (Visit) → OK

The name of the variables contained in the file must be the followings: x_velocity, y_velocity, z_velocity, pressure, density, temperature, viscosity and eddy_viscosity.

### 3.10 Potential Flow Generator files

Epsilon can also be used to analyze data coming from the “Potential Flow Generator”. It is a Paraview data source developed by ISAE, allowing determining the potential flow field around a cylinder or an airfoil (by using transformations):

Sources → Potential Flow Generator → Set up desired parameters → Apply
48

The name of the variables contained in the file must be the followings: X_VELOCITY, Y_VELOCITY, Z_VELOCITY, PRESSURE, DENSITY, TEMPERATURE, MU_LAM and MU_TURB.

4 EXTRACT BLOCK/MERGE BLOCKS

CFD data must be pre-treated before applying Epsilon Aero Data filter:

4.1 Extract Block

This step is only mandatory for grid adaption cases. CFD cases without an adapted mesh must skip this step.

In an adapted CFD case, extra blocks are created for the refined regions. If all those blocks are loaded (i.e., the original mesh blocks + the blocks of the refined regions) a visualization problem arises as shown in Figure 15:

![Figure 15: visualization problem](image)

This problem is not limited to the visualization but also to the data itself, because the aerodynamic variables are missing in these new blocks. This is solved by applying an Extract Block filter and by selecting all blocks except the blocks concerning the refined regions. The result is shown in Figure 16:

![Figure 16: output from Extract Block filter](image)

Even though some cells at the limits of the refinement region are now missing, it does not represents a problem for the aerodynamic analysis by Epsilon.
4.2 Merge Blocks

The current version of Epsilon (V2.0) does not support multiblock data sets, hence a Merge Blocks filter must be applied. A more efficient multiblock analysis will be supported in future Epsilon versions.

5 EPSILON AERO DATA

At this point we are ready to implement the aerodynamic analysis equations (i.e., near-field, far-field, Lamb vector and exergy). This is made by applying the “Epsilon Aero Data” filter.

First make sure that you have selected the input data (The Epsilon Wind Tunnel filter or the Merge Blocks filter) in the pipeline browser (it must be highlighted in blue), and then apply the Epsilon Aero Data filter as follows:

Filters → Epsilon → Epsilon Aero Data

5.1 Filter setup

Before clicking on the “Apply” button, it is necessary to setup the filter by using the properties panel as seen in the Figure 17.

![Figure 17: Epsilon Aero Data properties panel](image)
The option “Script” allows modifying the Path to the Python file. If the installation procedure recommended in the previous chapter was followed, the user must ignore this option.

The user must define which type of data has been loaded by using the “Input Format” drop down list. Then it must be specified the mesh upwards direction as well as the angles of attack and sideslip. This information allows defining the parameters of the transformation matrices discussed in Chapter 1.

Then it must be specified some upstream reference data, which allows calculating all the upstream parameters. First of all, the airspeed can be defined as a Mach number value or a Velocity value, by using a drop-down list. Then, its airspeed value must be indicated. The pressure and temperature are also necessary, so the user can define these values as static or total values by using another drop-down list and by indicating their values in a dedicated panel. The reference surface value must be specified: it is used to calculate the forces and exergy coefficients. This reference surface is equal to the **airfoil chord** in 2D cases and equal to the **wing surface** for 3D cases. The 2D cases consider that the depth is unitary, thus the 2D reference surface equals the chord times the unitary span length.

The parameters described above are the ones to modify each time Epsilon Aero Data filter is applied. The remaining parameters are optional.

The “Nondimensionalize” button (activated by default) allows showing drag, lift, exergy and anergy coefficients instead of its dimensional values.

The user can also select the desired output variables. All methods are activated by default which is suited for most of analyses. However, it must be kept in mind that the computation time and the **required memory to store the output data** could be demanding for 3D CFD cases with a large amount of cells.

Lamb vector calculations also require to define the field dimension (2D or 3D field). This can be made by using a drop down list.

### 5.2 Output messages

After defining the previously discussed parameters the Epsilon Aero Data filter can be executed (“Apply” button). By doing so, the Paraview’s output messages window will display some information as shown in Figure 18 (in order to see it properly, the user must active the option “**View Full Messages**” or “**Console View**” in the output messages window).

First of all, it informs the user that the Python code has recognized the input data as 2D or 3D data. It also indicates if the output data will be non-dimensionalized or not. These are only confirmation messages. No further action is required.

The last message shows the **survey plane normal values** to be used later by the user in order to setup the survey plane inclination. Thus, it is advised not to clear the Paraview’s Output Messages window; otherwise, this information will be lost. Nevertheless, this information can be recovered by simply re-executing (Apply) the Epsilon Aero Data filter again.
5.3 Visualizing the aerodynamic data

After executing Epsilon Aero Data, we are ready to exploit the aerodynamic parameters calculated. This aerodynamic data can be quickly displayed by clicking on the drop-down list tagged as “Solid Color” in the menu bar as shown in Figure 19. This will show the list of data arrays available. By selecting any property, the mesh will be automatically colored. The meaning of each parameter of this drop-down list is indicated in the Appendix 1. The physical interpretation of most of these parameters is presented in [25, 26].

IMPORTANT: in order to easily manipulate the 2D object on the screen (i.e., zoom or pan-and-tilt) the “3D” button must be activated in advance (it is highlighted in red in the Figure 19).

By default, color map is scaled to contain the maximum and minimum values. If a custom range is needed, the scale color map options marked in red in Figure 20 must be used.

In order to see the flow pattern in 2D cases, go to the menu bar and search the drop down list named “Surface”, then select the “SurfaceLIC” option (See Figure 21). Note that this streamlines can be easily colored by some aerodynamic parameter by simply selecting the desired array in the menu bar. This approach has the drawback that no filter parameter can be changed to modify the visualization (line density and line thickness are already fixed).
IMPORTANT: it is forbidden to activate the full-screen mode (F11 keyboard button) while displaying the surface LIC flow pattern. This will make Paraview to crash and close (It is a bug).

![Figure 20: color map scale](image1)

![Figure 21: surface LIC display](image2)

6 EPSILON AXES (OPTIONAL)

This stage is optional but it is recommended for beginners because it helps to interpret the output data from Epsilon Aero Data. This filter creates a set of 3 vectors representing the aerodynamic axes:

Filters → Epsilon → Epsilon Axes

The user must only define the size of the vectors and the position of the origin of these vectors (Fig. 22)

![Figure 22: Properties panel for the Epsilon References Axes source](image3)

The vectors are not labelled like the mesh vectors. However they have the same color code: Red=x-axis, yellow=y-axis, green=z-axis (See Figure 23).
This color code must be activated by selecting the variable “Colors” and its option “Magnitude” in the tool bar drop-down list as shown in Figure 24. If the user wants to hide the “Colors Magnitude” legend in the visualization, the button highlighted in red must be deactivated:

**Figure 24: wind axes ID coloring**

**IMPORTANT**: the default color map MUST be BGR (blue-green-red). Otherwise, the color code will be meaningless.

7 **PARAVIEW ANALYSIS**

The output from Epsilon Aero Data can be further analyzed by using the standard ParaView tools. For 2D cases, there are three filters particularly useful: Plot On Intersection Curves, Integrate variables and warp by scalar.

7.1 **Plot On Intersection Curves**

One of the most practical 2D data analysis is the observation of the aerodynamic parameters distribution along the survey line (Survey line = trace of the survey plane in 2D cases). In order to plot the aerodynamic parameters along a survey line, a “Plot On Intersection Curves” standard filter must be applied directly to the Epsilon Aero Data output:

Filters → Alphabetical → Plot On Intersection Curves

By default it defines an intersection plane whose origin and normal must be defined by the user (Figure 25):
The “origin” has 3 boxes to preset the x-, y- and z-coordinates. The user must use the x-coordinate to place the survey plane at the intended position (usually downstream of the body).

The normal direction of the plane must be settled by the user based on the output message of the Epsilon Aero Data filter (“NORMAL DIRECTION TO USE FOR SLICE PLANE OR INTERSECTION LINE”).

Note: it is advised to deactivate the “Show Plane” checkbox because it may annoys during the manipulating of the render view object.

After applying the filter, a new window will be displayed (“Line Chart View” type). By clicking on this window, its properties will be accessible as shown in Figure 26. The user must ensure that all the boxes under “Composite Data Set Index” are checked. Then, it is possible to select the parameter to be plotted along the x-axis by choosing the desired parameter in the “X-Array Name” drop-down list. The parameter to be plotted along the Y-axis must be selected from the “Series Parameters” list. It is recommended to plot the Y-coordinates (Points_Y or Points_Z) along the Y-axis and the aerodynamic parameter along the X-axis as it is shown on the right hand side of the Figure 26.

Note: the user may want to visualize the actual survey line overlaid on the 2D flow field in order to have an idea of its position. This can be made by clicking on the Render View in order to set this window as the active
window. Then, go to the Pipeline Browser and click on the “visualize/hide icon” highlighted in red in Figure 27. When it is in gray color, it is hidden. When it is in black color, it is shown on the active window. This visualization tool works in the same fashion for any element on the Pipeline browser and it changes of course from one active window to the other.

![Pipeline Browser](image)

Figure 27: show or hide an element

### 7.2 Integrate variables

So far we were concerned with data visualization. However the main objective is to obtain the value of drag, lift, exergies, and so on. This is achieved by integrating the data contained on the survey plane (survey line in 2D CFD cases). This is because the drag distributions shown before are in fact drag densities: any variable calculated by Epsilon represents just the integrand of the equations presented in Chapter 1 (The detail of each parameter is available in the Appendix 1). In order to obtain the integrated value of the equations, an integration of the density data must be carried out.

Select again the “PlotOnIntersectionCurves” filter on the pipeline browser and apply the “Integrate Variables” filter:

**Filters → Alphabetical → Integrate Variables**

A new window will appear in a table format (Spreadsheet view), showing the integrated value of each parameter contained in the survey line as shown in Figure 28.

![Spreadsheet view](image)

Figure 28: integrated values

**Important**: The user must keep in mind that the integrated values of the integrands give the total value of these parameters (For example, the integration of Betz Profile Drag density will give the actual value of profile drag). On the other hand, the integrated value of any other field data than the equation integrands is meaningless (like the “ARNTZ_Ep” integral). Also, the integration of the wave anergy and the viscous anergy densities (among others) are **meaningless**. This is because these integrands require a volume integration to give the viscous and wave anergy (so, its plane integration is meaningless, or at least it can be interpreted as the local anergy generation rate at the survey plane position).
7.3 Warp by scalar/Clip by scalar

As we have seen in Figure 26, the “Plot On Intersection Curves” filters allows plotting data in a separate window. However, it may be difficult to relate the data values with its spatial position. So, it would be nicer to have the same plot but superimposed to the survey line as shown in Figure 29, where the vertical white line is the survey plane and the red curve is the qualitative profile drag distribution along this line:

![Figure 29: warp by scalar](image)

This is achieved by applying a “Warp By Scalar” filter to the existing “Plot On Intersection Curve”:

Filters → Alphabetical → Warp By Scalar

The user must select the aerodynamic parameter to do the warp of the survey line by using the “Scalars” drop-down list (Figure 30). Then he must select the proper warp direction (it should be normal to the survey plane: use the “normal direction” printed in the output messages window). If necessary, the warp magnitude can be enlarged or reduced by using the Scale Factor:

![Figure 30: warp by scalar parameters](image)

This feature is also extremely useful to detect a possible drag density shift as it is shown in Figure 31. In fact, sometimes the small numerical errors gives a non-zero drag density outside the wake region. Instead, a slightly positive drag value is encountered in the zones outside the wake. Thus, when integrating the drag density all along the line, the resulting drag value will be wrong or biased. So, it is advisable to check if the density is shifted by using the “Warp By Scalar” filter.
If a drag density exists, the simplest way to improve the accuracy of the drag prediction is to limit the integration zone to the wake region (in fact, this shift appears in WTT far-field methods that require a wake integral only). The user must select the “Epsilon Aero Data” filter in the pipeline and then apply the Clip filter:

Filters → Alphabetical → Clip → Clip type → scalar

Scalars → Select the desired parameter
Value → indicate the threshold value

The parameter to be selected must be such that it varies only inside the wake (you can use $P_t/P_{t0}$, a drag density or the total anergy variable). The threshold value will depend on the selected variable (for $P_t/P_{t0}$, a good starting value is 0.9999). Hence, by applying this filter, only the zone inside the wake will be kept as shown in Figure 32. Then this output can be used to make a “Plot Over Line” followed by “Warp by Scalar”.

It can be seen that the survey line no longer contains the shifted non-zero values outside the wake. Thus, by integrating data along this new clipped line, an accurate drag value will be obtained. This is the standard recommended procedure for drag extraction in Epsilon for any far-field method and for the WTT-exergy.
method (Aguirre). The only precaution to take care about this procedure is to avoid excessively cropping the wake by using an aggressive clipping value. Another possible issue is that sometimes the clipped survey line does not allow to be integrated (a very rare situation). In this case the integrated value shows a “NaN” legend in the spreadsheet view. This means that Paraview was unable to integrate the array because of some missing data along the line. The simplest way to overcome this is by clipping a box around the desired wake region, then to apply the survey line on this box and to integrate values.

If the user is looking for highly accurate drag values, the remaining drag density shift still present inside the clipped wake must be manually removed (see Figure 32). This is made by inspecting two parameters on the Spreadsheet view: the length of the survey line and the shift drag value.

The length is visible by selecting the “Integrate Variables” and the by changing the attribute from “Point Data” to “Cell Data” (Figure 33). The field “Length” shows the line length.

On the other hand, the shift drag value is the value used for clipping the domain (Thus this value is still available in its related Property Panel). It can also be obtained by selecting on the spreadsheet view the “PlotOnIntersectionCurves” and “Point Data”. Then, by inspecting the desired drag density column one can identify the minimum drag value (Figure 34).

The product of both values (line length x shift drag density) will give the shift drag inside the wake: this value must be removed from the integrated one. The order of magnitude of this shift drag goes from 0.1 to 1.5 drag counts, thus it is a small error that can be absolutely negligible unless highly accurate drag values be desired.

The methods indicated in this section are valid for 2D cases and 3D cases as well. The user must consider the good practice of clipping by scalar the wake before attempting any wake integration procedure. This is valid for far-field methods and WTT exergy formulation (Aguirre) only: DON'T DO THAT for the CFD exergy formulation (Arntz).
8 EPSILON PROFILE DRAG BREAKDOWN

Another interesting feature provided by Epsilon is the profile drag decomposition based on Kusunose’s approach, i.e., profile drag = viscous + wave (or, equivalently, the exergy/anergy breakdown into viscous/wave components by the Aguirre’s method).

Select again “Epsilon Aero Data” in the pipeline browser and apply the following filter:

Filters → Epsilon → Epsilon Profile Drag Breakdown

This will display the properties panel shown in Figure 35, which must be configured before clicking on “Apply”. As usual, the “Script” window allows changing the path of the Python filter. It must not be modified if the standard installation procedure described in Chapter 3 was followed.

This filter applies the breakdown method to a single variable at time: its output splits the field of the selected variable into three components called “wave”, “viscous” and “jet”. The latter identifies the regions with negative drag (i.e., jet plume).

Hence, the user must first select the desired variable to decompose by using the drop down list. Then, it must be setup two thresholds factors which are used to define a criterion to detect the wave drag. These threshold values can be defined as absolute values or relative to the maximum values. By default, “absolute values” option is activated in the checkbox. If unchecked, Epsilon will interpret this as “relative values”.

If the “absolute values” definition is used, the wave drag region exists where: (Profile Drag<Drag Threshold) and (Vorticity < Vorticity Threshold).

If “relative values” are used, the wave drag region exists where: (Profile Drag<Drag Threshold*Maximum Drag) and (Vorticity < Vorticity Threshold*Maximum Vorticity).

The default absolute threshold values have been settled based on typical data but it may not work fine for all cases. Thus, the user must play with those values in order to obtain the correct decomposition. The quickest way to do so is to observe the output fields of the filter. In fact, the filter provides 5 output arrays: “Jet”, “Profile Drag”, “Vorticity_Magnitude”, “Viscous” and “Wave”. “Profile Drag” is the same array that has been selected to decompose (e.g., if you selected “MEHEUT_Profile_Drag”, then the output called “Profile_Drag” is that same array -it has been repeated for convenience-). “Vorticity_Magnitude” is again a copy of that variable that comes from Epsilon_Aero_Data. Hence, “wave”, “viscous” and “Jet” are the actual new outputs.
Then, the procedure to verify if the threshold values were correctly settled is the following. First, visualize the “Profile_Drag” field and find the correct range value limit that allows you to observe the shockwave as shown in Fig. 36-left. Then visualize the wave (Fig. 36-right) and viscous components (Fig. 37) by using the same data range. If the wave output does not contain any trace of the viscous region, then the breakdown was successful.

![Figure 36: Profile Drag field (left) and wave drag (right)](image)

![Figure 37: viscous drag](image)

Another option of the filter GUI is “Breakdown by Exergy Method” (unchecked by default). If this option is selected, then, instead of using the Kusunose method, the Aguirre method is used. In this case, vorticity is no longer used to define the wave region, instead the viscous anergy rate parameter is used (“ARNTZ_Aphi” variable from the Epsilon Aero Data output). The advantage of this option is that the viscous anergy field is a more reliable parameter to define the threshold region [31].

If the “Breakdown by Exergy Method” option is selected, then, the viscous anergy threshold must be specified by using the same input box than the vorticity (The same box was kept in order to simplify the GUI).

### 9 EPSILON INTEGRATION TOOL

Epsilon Integration Tool is a versatile analysis tool that allows you to quantify and visualize the evolution of the integral of certain parameters along a specified direction. For 2D applications, the output is a line data. Select again “Epsilon Aero Data” in the pipeline browser and apply the following filter:

Filters → Epsilon → Epsilon Integration Tool

The related properties panel is shown in Figure 38 and it must be properly configured before clicking on “Apply” button. The “Output Type” must be “Line Distribution” for 2D cases. However, the rest of the parameters must be configured depending on the stage of the analysis. In fact, this filter must be used in a three-step procedure:
1) Creation and visualization of the line along which the survey plane integrals will be performed
2) Visualization of the survey plane
3) Integration of data at each survey station and storing this data along the line

The first step requires defining the integration line direction. This is achieved with the “Axis” drop down list: select the axis along which the integral will be performed. For 2D cases you can use either “Aerodynamic x-axis” or “Mesh X-axis”. Then the position of this line and the amount of points along it must be defined. This is made by using the left column of the input data table (the right column will be used in 3D cases). Then select “Visualize Line” in the “Select Action” drop-down list and click on “Apply”: this will create a line in the render view. In order to visualize the actual points of the line, change the visualization type from “surface” to “points”. The result is shown in Fig. 39. The points are the positions of the survey plane used later to integrate data.

![Properties (EpsilonIntegrationTool)](image)

**Figure 38: Epsilon Integration Tool properties panel**

![Points along the integration line](image)

**Figure 39: Points along the integration line**

This is also the best moment to correct the position of the line ends as well as the point density. Just modify those parameters in the properties panel and click again on “Apply”. This will update the visualization.

Now you can go to the second step: the visualization of the survey plane that will be used for the integration of the aerodynamic parameters. This is achieved by changing “Select Action” from “Visualize Line” to “Visualize Plane”. Then click on “Apply” and the survey plane will be displayed roughly at the center point along the integration line as shown in Fig. 40 (make sure you select the visualization mode back to “surface” again). This step is required to visually confirm that the survey plane is normal to the upstream flow direction.
Figure 40: Survey plane visualization

The final step is the actual integration of the parameters on the survey plane for each plane position defined by the points of the integration line: change “Set Action” to “Perform Automatic Integration” and click on “Apply”. Few seconds later an output line will be created which contains the integrated values at each point. The time required to integrate the values depends on the amount of plane positions (line points) and the CFD grid density. It is advised to start with 100 points for 2D cases in order to have a first idea of the output, then increase it to the desired value.

There are three ways to visualize the output of this integrated data in 2D cases. The first-one is to visualize the distribution of a given integrated parameter on the top of the field as shown in Fig. 41. This is achieved by using “Warp By Scalar” filter. This method is suited for a qualitative visualization.

Figure 41: Visualization of the integrated “ARNTZ_A” field (white line) along the integration line (black)

If a quantitative visualization is required, select the “Epsilon Integration Tool” in the pipeline browser and apply the “Plot Data” filter:

Filters ➔ Alphabetical ➔ Plot Data

The setting of the filter is identical to “Plot On Intersection Curves” filter. The result is shown in Fig. 42.
The third way to visualize data is to export it to your favorite code (Python, Matlab). This is achieved by using the “Spread Sheet View”: first select “Epsilon Integration Tool” in the pipeline browser. Then create a new layout of type “Spread Sheet View”. This gives you a table with all the integrated data that can be exported into a CSV file by clicking on the button highlighted in red in Figure 43.

![Figure 42: Plot of the integrated “ARNTZ_A” field along the integration line](image)

There are two options of the “Epsilon integration Tool” that haven’t been described yet: “Flip Clip Normal” and “Select Variable”. “Flip Clip Normal” is reserved for 3D applications, however, “Select variable” is used in both, 2D and 3D cases.

“Select variable” is a drop down list with seven options. The user must select the proper option depending on the intended application as follows:

- **Infinite surface formulations**: it can only be used when the survey plane slices the entire CFD domain (as shown in Figure 40).
• **Wake surface formulations**: it can only be used if the CFD domain has been clipped prior to the application of the Epsilon Integration Tool, in order to integrate data only inside the boundary layer and wake regions as shown in Fig. 44.

• **Volume formulations**: it must be selected to integrate only the volume formulations (e.g., the local viscous anergy rate). In this case, instead of using a survey plane, a clip filter is used to integrate the volume data upstream of the survey plane.

• **Body surface formulations**: this option is reserved for 3D cases.

• **Profile drag breakdown**: it must be used when the integration tool is applied to the Epsilon Profile Drag Breakdown filter.

• **Maskell lift/sideforce**: this option is reserved for 3D cases.

• **AERO parameters**: it integrates the classical aerodynamic parameters from Epsilon Aero Data.

![Figure 44: Output visualization example for the “Wake surface formulations” case with clipped domain](image)

## 10 EPSILON NEAR FIELD

This tool allows calculating the near-field forces and moments acting upon the body surface. **This filter must be applied to an actual surface**, but not to edges or volume data. This means that if the 2D CFD mesh is already extruded (as the Open Foam cases), it is enough to extract the surface of the domain:

Filters → Alphabetical → Extract Surface

However, most of 2D CFD grids are planar (e.g., Fluent files). In these cases, the 2D body surface must be reconstructed by adding the following steps to the extracted surface:

Filters → Alphabetical → Feature Edges

Filters → Alphabetical → Linear Extrusion

“Feature Edges” filter detects the edges of the grid (Figure 45-left). This includes the actual body (e.g., an airfoil contour) but also the limits of the CFD domain. “Linear Extrusion” filter takes these contour lines and extrudes them in order to create an extruded surface perpendicular to the mesh plane (Figure 45-right).
Now we have the surface required to apply the “Epsilon Near Field” filter:

Filters → Epsilon → Epsilon Near Field → Apply

The parameters of the filter will be discussed later. First, an intermediate step is required. The fact is that the Linear Extrusion filter also extrudes the boundary domain contour (Fig. 46-left) and this must be taken away from the data. This is achieved by using a “Clip” filter of “Box” type (Fig. 46-center) that only retains the airfoil geometry (Fig. 46-right). The steps are the followings (See property panel details in Figure 47):

Filters → Alphabetical → Clip → Clip Type → Box
   → Show Box → Activate
   → Scale → Set a value smaller than 1 (the box must fit inside the boundaries)
   → Invert → Activate
   → Apply
   → Show Box → Deactivate (because this box annoys the visualization)
Now that the surface of the body is only present we can go back to the Epsilon Near Field filter and verify its setting as shown in Figure 48. The most important feature is to verify the normal direction. In fact, the proper calculation of lift, drag and moment values relies on **outward pointing normal**. Hence, the user must visualize the “Normals” variable along the aerodynamic Z-axis (Normals is a vector variable). This must display the normal colors as shown in Figure 49. If not, the option “Flip normal” must be activated.

On the other hand, “Cref [m]”, “X0 [m]”, “Y0 [m]” and “Z0 [m]” are the reference cord and reference center coordinates used for the moment calculation.

Finally, it is possible to integrate the output from this filter in order to obtain the lift, drag and moment acting on the 2D body.
11 PARAVIEW TIPS

11.1 Improving legend labels

The scale range numbers in the label of any Parameter are displayed by default with scientific notation (Figure 50-left). If you want to use standard numbers instead (Figure 50-right), you have to open the “Edit Color Legend Properties”, then click on the advanced properties button and then change the range label format: replace the “e” by an “f” (Figure 51). Also, the number of decimal can be changed by modifying the number in front of “e” (i.e., change “6.1” to “6.3” if 3 decimals are desired). Moreover, the same control panel allows changing the name of the variable displayed (it accepts Latex format).

![Figure 50: standard label (left) and new label type (right)](image)

![Figure 51: edit color legend properties](image)

11.2 Paraview state file

Once the series of filters have been applied, it is possible to save the entire setup by using the state files:

File → Save State → Chose name of file

It can be loaded back into Paraview in this way:

File → Load State... → Load “FileName.pvsm” file
CHAPTER 5: ANALYSIS OF 3D CFD DATA

The step-by-step procedure for a complete 3D analysis is shown in Figure 52.

Since we already discussed most of the analysis tools in the 2D case, here we will present only the remaining tools as well as the idea behind this new setup procedure for 3D cases. In general, a complete 3D analysis is made in three stages:

- Body surface analysis.
- Basic wake analysis.
- Detailed wake analysis.

1 BODY SURFACE ANALYSIS

This analysis is performed when the near-field forces and moments are required and also when the near-field lift and drag distributions along the span are needed.

1.1 Extract surface/Clip

The output data from Epsilon Aero Data do not allow separating the surface by name ID. Thus, in order to separate the surface of the body from the symmetry plane and the domain boundary surfaces it is necessary to manipulate a little bit the geometry data.

Firstly it is necessary to extract the surface from the entire data set (which contains the volume data as well as the surface data). Select the “Epsilon Aero Data” filter on the Pipeline Browser, and then apply this filter:
Filters \rightarrow Alphabetical \rightarrow Extract Surface

At this stage, the 3D visualization will not change as it is shown in the Figure 53-left (it just deletes the internal points data). So, we need to find a way to hide the surfaces surrounding the body. This can be easily achieved by using a clip filter to cut away the unwanted surfaces. Thus, select the “Extract Surface” filter from the Pipeline browser and then apply the “Clip” filter:

Filters \rightarrow Alphabetical \rightarrow Clip

The “Clip Type” must be a box: we will use this box to surround only the body and to clip out the external geometry. By default, this box encloses the entire geometry (Figure 53-center). Thus, this box must be scaled down in order to only enclose the body (Figure 53-right). This is made by setting a value smaller than 1 in the “Scale” option (Figure 55). Also, a very small translation of the box is required in order to exclude the symmetry plane from the selection. Finally, by selecting the option “Inside Out” we retain only the geometry enclosed by this box, as it is shown in the Figure 54–left. Then, by deactivating the “Show Box” option we get only the body (Figure 54 – right). The resulting geometry can be colored by all the Epsilon Aero Data parameters and even the surface flow pattern can be seen by using the surface LIC as mentioned in the 2D case.
1.2 Epsilon Near Field

This filter is placed between the “Extract Surface” and “Clip” filters as it was explained in the 2D example. Once the domain is clipped by retaining only the geometry, it is possible to obtain lift, drag and moments by integrating data on the entire body surface (use “Integrate variables” filter). The resulting integrated values will be displayed in a “Spread Sheet” window.

1.3 Epsilon Integration Tool

This filter can be applied to the output of the “Extract Surface + Epsilon Near Field + Clip” sequence, in order to obtain the spanwise lift or drag distribution by the near-field method. The setup is identical to the 2D case. The only exception is that the variable “Body Surface Formulations” must be selected for the integral. The output can be visualized with “warp by scalars” or “plot data” filters as usual.

2 BASIC WAKE ANALYSIS

This analysis provides a quick assessment of the far-field, Lamb vector and exergy parameters by analyzing data on the survey plane.

2.1 Slice CFD domain

The survey plane can be created by using the “Slice” filter. It is a standard Paraview tool to create a plane crossing the entire CFD domain into which the CFD data is interpolated. Firstly, select “Epsilon Aero Data” from the Pipeline browser and then apply the following filter:

Filters → Alphabetical → Slice

It is recommended to deactivate the “Show Plane” option on the properties panel (Figure 57) because one may change inadvertently the plane position with the mouse. The plane axial position along the X-axis must be defined by the user but its inclination must be settled up by using the output messages from Epsilon Aero Data:
These printed normal vector directions must be introduced on the plane’s normal definition on the properties panel (Figure 57).

The resulting slice plane (survey plane) can be colored by any Epsilon Aero Data parameter (Figure 58), and even it allows showing the surface LIC flow pattern.

2.2 Clip wake region

WTT formulations require data on the wake region only. Thus, the survey plane must be clipped before integrating its data (Figure 59). This visualization of the data on the clipped plane can be improved by using “Warp By Scalar” filter or “Plot On Intersection Curves” (Figure 60).
2.3 Integrate variables

For 3D cases, the far-field and exergy parameters displayed on the slice plane are the corresponding “densities” (i.e., the integrand of the far-field and exergy equations), so this plane data can be directly integrated by using the “Integrate Variables” standard filter.

**Important**: The user must keep in mind that the integrated values of the integrands give the total value of these parameters (For example, the integration of Betz Profile Drag density will give the actual value of profile drag). However, the integration of wave anergy density, thermal anergy density or any other volume-based formulation is meaningless. This is because these integrands require a volume integration to give the thermal and wave anergy (so, its plane integration is meaningless or at least, it can be interpreted as the local rate of generation of anergy at the plane position). It is important that the user keep always in mind the equations already presented in Chapter 1.

2.4 Epsilon integration tool

This integration can also be made automatically for several plane positions by using “Epsilon Integration Tool” already described in the analysis of 2D CFD data. The parametrization for 3D cases is identical to the 2D cases and the sweep axis must be the mesh or aerodynamic x-axis as shown in Figure 61.

3D cases allow creating a different type of visualization: the 3D to 2D mapping (Figure 62).
This is achieved by using “Epsilon integration tool” with the “Output type” as “3D to 2D mapping”. Note that this time the “Axis” option to be selected is the normal direction of the integration plane mesh shown in figure 62. Moreover, for this option it is required to define number of points and start/end of the surface mesh along its two directions: this is made by filling both columns of the input table. Also, in “Select action” the “Visualize line” option is no longer needed. Instead, you should visualize the mesh plane with “Visualize plane” option. Finally, the selected variable to integrate will depend on the formulation you want to visualize.

3  DETAILED WAKE ANALYSIS

For most of applications, the basic wake analysis is enough. However, a detailed wake analysis will provide a deeper insight into the physics.

3.1  Profile drag breakdown

The first step is to visualize the shockwave: a Contour filter must be applied directly to the Epsilon Aero Data output:

Filters  →  Alphabetical → Contour

In its properties panel (Figure 63), the user must select the “Shock Detector” parameter on the “Contour By” drop-down list. Then, it is necessary to indicate its contour value in the “Value Range” option. This number must be settled to 0.95. The resulting visualization can be seen on the Figure 64:
Then, the “Epsilon Profile Drag Breakdown” filter must be applied either to the entire 3D data (i.e., the output from Epsilon Aero Data) or a slice (i.e., the survey plane). It is strongly recommended to start with the survey plane because it is faster to properly setup the drag breakdown parameters as it was explained in the 2D case. Once these parameters are OK, one can think about breaking down the entire CFD domain.

3.2 Induced drag with Epsilon Poisson Solver

The induced drag by WTT formulation is obtained by solving the Poisson equation:

Filters ➔ Alphabetical ➔ Epsilon Poisson Solver

Before clicking on the “Apply” button, some parameters must be settled up. As usual, the “Script” file path must not be modified if the recommended installation procedure has been followed (Figure 65).
The “wake survey type” drop down list is a parameter only valid for the case of Green functions: it allows the specification of the characteristics of data being analyzed. By default it considers that the CFD domain corresponds to a half-body (“Half-model geometry”). However a full-body is also available. This will affect the type of equation to be used (See the theoretical guide in Chapter 1). In fact, the “Upwards Direction” parameter explained before, allows the specification of the upwards mesh direction in order to know how to do the data reflection for the case of half-model geometry.

The “Sigma definition” drop down list allows choosing the way the “σ” parameter is calculated. The default approach takes into consideration the axial velocity derivative, while the alternative is to consider the transverse velocity gradients. Theoretically, both methods provide the same result. However, the use of the transverse velocity gradients is prone to some local numerical errors (spots of unphysical “σ” values and/or distorted regions) which are mesh refinement sensitive. It can be solved by simply refining the survey mesh.

The “Enable velocity potential” checkbox allows the user to decide whether or not to solve the Poisson equation for the velocity potential. Poisson equation for the stream function is always solved by default. However, the user must indicate if he wants to solve the Poisson equation for the potential velocity function: if this checkbox is not activated, then the Maskell equation terms containing the “Φ” symbol will be discarded.

After clicking on the Apply button, the user must wait some time while the Python file solves the Poisson equation. The resulting stream function will show a circle-like pattern around the high vorticity regions as shown in Figure 66.
The required time to solve the Poisson equation depends on the number of points at the survey plane mesh (this is the dominant factor) and the amount of equations to be solved (if the velocity potential is activated). An order of magnitude of this required time is shown in Figure 67 for a case without the velocity potential calculations.

![Figure 67: time required to solve the Poisson equation](image)

In order to know if the calculation has finished, an output message indicates the total calculation time required (This information is printed for any method).

Starting Poisson solver...
Calculation time 67.9409999847 Seconds (1.13234999975 minutes)

Once executed the Epsilon Poisson Solver, the stream function, potential function, vortex drag and other related parameters are accessible at the output. If needed, this data can be integrated by using the “Integrate Variables” filter, in order to have the total value of the vortex drag.

### 3.3 Spanwise distributions

Epsilon Integration Tool can be used to produce a typical aerodynamic analysis plot: spanwise distribution of different variables.

#### 3.3.1 Distribution of local variables

The first step is to create a slice plane either full size (infinite survey plane) or clipped (wake survey plane). Then, “Epsilon Integration Tool” is applied to this plane in order to integrate data along the span direction by following the same procedure as explained for 2D cases. The typical result is shown in Figure 68.
3.3.2 Lift distribution

In order to obtain the spanwise lift distribution by the Maskell method a similar procedure must be followed. The only exception is that the user must select “Maskell lift/sideforce” in the “Select Variable” drop down list. If required, the option “Flip Clip Normal” must be activated. In order to understand how this particular plot is created inside the filter and when is necessary to invert the clip normal, the internal functioning of the filter is explained as follows.

Internally, the filter takes the entire survey plane data as an input. Then it defines a certain spanwise station and finally it only integrates the survey plane data lying on the outside part of this station (i.e., from the desired station towards the wing tip). In fact, since the Maskell lift density distribution contains the axial vorticity, its related field must be interpreted as the local change in lift distribution (Figure 69).

Thus, in order to know the actual lift value at certain station, the integration of this lift density must be carried out on the area outside of this station (Figure 70). That’s why the survey plane data is clipped by the integration tool. This also explains why sometimes will be necessary to activate the “Flip Clip Normal” option: in some cases the normal may be pointing in the wrong direction which leads to the integration of the wrong side of the clipped plane.
Finally, this clip filter is animated in order to sweep it along the entire span of the wing. At each position, data is integrated and stored into a vtk polyline output. The resulting spanwise lift distribution can be obtained by using “Warp By Scalar” filter as it is shown in the Figure 71:

Figure 70: Maskell lift density clipped

Figure 71: spanwise lift distribution example, along with the Maskell lift density
APPENDIX 1

In this appendix there is a detail of all the output arrays for any Epsilon filter.

1 EPSILON AERO DATA

The list below follows an alphabetical order and it is also the same order shown in the Paraview’s GUI. For each variable, an ID is provided, which correspond to the number of equation presented on the Chapter 1. Moreover, a detail of the equation (or a term of its equation) coded into each variable is also provided. This allows the user to know explicitly the meaning of each variable. It must be noticed that all the variables represents the INTEGRAND of the equations of the Chapter 1. They DO NOT provide the integrated value of those equations.

<table>
<thead>
<tr>
<th>VARIABLE NAME</th>
<th>ID</th>
<th>EQUATION CODED IN THE VARIABLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>AERO_Cp</td>
<td>146</td>
<td>$P_s - P_{s0}$</td>
</tr>
<tr>
<td></td>
<td></td>
<td>$\frac{1}{2} P_0 U_0^2$</td>
</tr>
<tr>
<td>AERO_Cp_gradient</td>
<td>---</td>
<td>$\nabla C_p$</td>
</tr>
<tr>
<td>AERO_Helicity</td>
<td>---</td>
<td>$\frac{\nabla \cdot \omega}{</td>
</tr>
<tr>
<td>AERO_Hs</td>
<td>23</td>
<td>$c_p T_s$</td>
</tr>
<tr>
<td>AERO_Ht</td>
<td>24</td>
<td>$h_s + \frac{1}{2} V^2$</td>
</tr>
<tr>
<td>AERO_Ht-Ht0</td>
<td>---</td>
<td>$h_t - h_{t0}$</td>
</tr>
<tr>
<td>AERO_Keff</td>
<td>102</td>
<td>$c_p * \left( \frac{\mu}{0.7} + \left( \frac{\mu_{turb}}{Pr} \right) \right)$</td>
</tr>
<tr>
<td>AERO_Lambda_2</td>
<td>136</td>
<td>eigenvalue(S$^2 + (J - S)^2$)[.;1]</td>
</tr>
<tr>
<td>AERO_M</td>
<td>20</td>
<td>$\frac{V}{a}$</td>
</tr>
<tr>
<td>AERO_MU_EFF</td>
<td>104</td>
<td>$MU_{LAM} + MU_{TURB}$</td>
</tr>
<tr>
<td>AERO_MU_LAM</td>
<td>---</td>
<td>$\mu$ (CFD data)</td>
</tr>
<tr>
<td>AERO_MU_TURB</td>
<td>---</td>
<td>$\mu_t$ (CFD data)</td>
</tr>
<tr>
<td>AERO_Phi_eff</td>
<td>105</td>
<td>$\mu_{eff} \left[ 2 \left( \frac{\partial u}{\partial x} \right)^2 + 2 \left( \frac{\partial v}{\partial y} \right)^2 + 2 \left( \frac{\partial w}{\partial z} \right)^2 + \left( \frac{\partial u}{\partial y} + \frac{\partial v}{\partial x} \right)^2 + \left( \frac{\partial u}{\partial z} + \frac{\partial w}{\partial x} \right)^2 + \left( \frac{\partial v}{\partial z} + \frac{\partial w}{\partial y} \right)^2 \right] - \frac{2}{3} \mu_{eff} \left[ \frac{\partial u}{\partial x} + \frac{\partial v}{\partial y} + \frac{\partial w}{\partial z} \right]^2$</td>
</tr>
<tr>
<td>AERO_Ps</td>
<td>---</td>
<td>$P_s$ (CFD data)</td>
</tr>
<tr>
<td>AERO_Pt</td>
<td>21</td>
<td>$P_s \left( 1 + \frac{\gamma - 1}{2} M^2 \right)^\frac{\gamma}{\gamma - 1}$</td>
</tr>
<tr>
<td>AERO_Pt/Pt0</td>
<td>---</td>
<td>$\frac{P_t}{P_{t0}}$</td>
</tr>
<tr>
<td>AERO_Q_criterion</td>
<td>135</td>
<td>$\frac{1}{2} (\omega^2 - S^2)$</td>
</tr>
<tr>
<td>AERO_Rho</td>
<td>---</td>
<td>$\rho$ (CFD data)</td>
</tr>
<tr>
<td>Variable</td>
<td>Formula</td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>AERO_Shock_Detector</td>
<td>( \frac{\nabla \cdot \nabla P_s}{a</td>
<td>\nabla P_s</td>
</tr>
<tr>
<td>AERO_Strain</td>
<td>strain(AERO_Vector_Speed)</td>
<td></td>
</tr>
<tr>
<td>AERO_Stress(tau)</td>
<td>( \text{MU}_\text{EFF} \times \text{strain} )</td>
<td></td>
</tr>
<tr>
<td>AERO_Ts</td>
<td>( T_s ) (CFD data)</td>
<td></td>
</tr>
<tr>
<td>AERO_Tt</td>
<td>( T_s \left(1 + \frac{\gamma - 1}{2} M^2 \right) )</td>
<td></td>
</tr>
<tr>
<td>AERO_V_gradient</td>
<td>( \nabla \tilde{V} )</td>
<td></td>
</tr>
<tr>
<td>AERO_Vabs</td>
<td>( \sqrt{V_x^2 + V_y^2 + V_z^2} ) \to Mesh reference frame</td>
<td></td>
</tr>
<tr>
<td>AERO_Vorticity</td>
<td>( \dot{\xi} \hat{i} + \eta \hat{j} + \dot{\zeta} \hat{k} )</td>
<td></td>
</tr>
<tr>
<td>AERO_e</td>
<td>( c_v T_s )</td>
<td></td>
</tr>
<tr>
<td>AERO_q</td>
<td>( \frac{1}{2} \rho V^2 )</td>
<td></td>
</tr>
<tr>
<td>AERO_s-s0</td>
<td>( s - s_0 )</td>
<td></td>
</tr>
<tr>
<td>AERO_u</td>
<td>( \tilde{T} \cdot \tilde{V}_\text{mesh} ; 0 )</td>
<td></td>
</tr>
<tr>
<td>AERO_vdelta</td>
<td>( u - U_0 )</td>
<td></td>
</tr>
<tr>
<td>AERO_v</td>
<td>( \tilde{T} \cdot \tilde{V}_\text{mesh} ; 1 )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_AERO_Hs_bar</td>
<td>( c_p T_s - c_p T_s^* )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_AERO_Hs_star</td>
<td>( c_p T_s^* )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_AERO_Rho_bar</td>
<td>( \rho - \rho^* )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_AERO_Rho_star</td>
<td>( \rho_0 \left[ 1 + \frac{\gamma - 1}{2} M_0^2 \left(1 - \frac{V^*^2}{u_0^2}\right)\right]^{\frac{1}{\gamma - 1}} )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_AERO_Ts_bar</td>
<td>( T_s - T_s^* )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_AERO_Ts_star</td>
<td>( T_s \left[ 1 + \frac{\gamma - 1}{2} M_0^2 \left(1 - \frac{V^*^2}{u_0^2}\right)\right] )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_AERO_Vabs_star</td>
<td>( u_0 \left[ 1 - \frac{2}{(\gamma - 1) M_0^2} \left(\frac{P_t}{P_0}\right)^{\frac{(\gamma - 1)}{\gamma}} \right] )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_AERO_e_bar</td>
<td>( c_v T_s - c_v T_s^* )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_AERO_e_star</td>
<td>( c_v T_s^* )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_AERO_u_bar</td>
<td>( u - u^* )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_AERO_u_star</td>
<td>( \text{AGUIRRE_Vabs_star<em>algs.cos(FlowTita)}</em>\text{algs.cos(FlowBeta)} )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_AERO_v_bar</td>
<td>( v - v^* )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_AERO_v_star</td>
<td>( \text{AGUIRRE_Vabs_star<em>algs.cos(FlowTita)}</em>\text{algs.sin(FlowBeta)} )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_AERO_w_bar</td>
<td>( w - w^* )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_AERO_w_star</td>
<td>( \text{AGUIRRE_Vabs_star*algs.sin(FlowTita)} )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_Aw_div_MASKED</td>
<td>( \nabla \cdot (T_s_0 \rho \frac{\delta s}{\delta V}) ) + Masking by negative Q_criterion</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_Cd_bar</td>
<td>( \text{ARNTZ}_A + \text{AGUIRRE_Em_bar} + \text{AGUIRRE_Eth_bar} )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_Cd_bar_corrected</td>
<td>( C_{D_e}^p +</td>
<td>C_{D_e}^f</td>
</tr>
<tr>
<td>AGUIRRE_Cd_star</td>
<td>( \text{AGUIRRE_Em_star} + \text{AGUIRRE_Eth_star} )</td>
<td></td>
</tr>
<tr>
<td>Equation</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_Em_bar</td>
<td>AGUIRRE_Eu_bar + AGUIRRE_Ev_bar + AGUIRRE_Ep_bar</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_Em_bar_corrected</td>
<td>130 ( \frac{1}{\epsilon_m + i_{\epsilon m}^{\text{wake}}} )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_Eu_bar</td>
<td>AGUIRRE_Eu_star + AGUIRRE_Ev_star + AGUIRRE_Ep_star</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_Ep_bar</td>
<td>127 ( \frac{E_p - E_p^*}{\epsilon_m - \epsilon_m^{\text{wake}}} )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_Ep_star</td>
<td>( (P_s - P_0)(AGUIRRE_u_{-}\text{star}\text{-}V_0) + AGUIRRE_Eth_p_star )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_Eth_bar</td>
<td>128 ( \frac{\epsilon_{th} - \epsilon_{th}^{\text{wake}}}{\epsilon_m - \epsilon_m^{\text{wake}}} )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_Eth_star</td>
<td>AGUIRRE_Eth_t_star</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_Eu_bar</td>
<td>125 ( \frac{E_u - E_u^*}{\epsilon_m - \epsilon_m^{\text{wake}}} )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_Eu_star</td>
<td>( 0.5 \cdot \rho \cdot (AGUIRRE_u_{-}\text{star}\text{-}V_0)^2 \cdot \epsilon_m )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_Ep_bar</td>
<td>126 ( \frac{E_p - E_p^*}{\epsilon_m - \epsilon_m^{\text{wake}}} )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_Ep_star</td>
<td>( 0.5 \cdot \rho \cdot (AGUIRRE_v_{-}\text{star}\text{-}V_0)^2 \cdot \epsilon_m )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_INF_Cd</td>
<td>ARNTZ_A + AGUIRRE_INF_Em + AGUIRRE_INF_Eth</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_INF_Em</td>
<td>ARNTZ_A + AGUIRRE_INF_Ep + AGUIRRE_INF_Eth</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_INF_Ep</td>
<td>112 ( \frac{E_{\text{p Arntz}}}{\epsilon_{th \text{pressure}}} )</td>
<td></td>
</tr>
<tr>
<td>AGUIRRE_INF_Eth</td>
<td>113 ( \frac{E_{\text{p Arntz}}}{\epsilon_{th \text{pressure}}} )</td>
<td></td>
</tr>
<tr>
<td>ARNTZ_A</td>
<td>108 ( T_{S0} \cdot \rho \cdot \delta s \cdot u )</td>
<td></td>
</tr>
<tr>
<td>ARNTZ_Aphi</td>
<td>99 ( \frac{T_{S0}}{T_s} \cdot \phi_{\text{eff}} )</td>
<td></td>
</tr>
<tr>
<td>ARNTZ_At</td>
<td>100 ( \frac{T_{S0}}{T_s} \cdot k_{\text{eff}} \cdot (V^2)^2 )</td>
<td></td>
</tr>
<tr>
<td>ARNTZ_Aw_div</td>
<td>106 ( \nabla \cdot (T_{S0} \cdot \rho \cdot \delta s \cdot V) )</td>
<td></td>
</tr>
<tr>
<td>ARNTZ_Aw_div_MASKED</td>
<td>( \nabla \cdot (T_{S0} \cdot \rho \cdot \delta s \cdot V) ) + Masking by Shock_Detector</td>
<td></td>
</tr>
<tr>
<td>ARNTZ_Cd</td>
<td>94 ARNTZ_A + ARNTZ_Em + ARNTZ_Eth</td>
<td></td>
</tr>
<tr>
<td>ARNTZ_Em</td>
<td>95 ( \frac{1}{2} \cdot \rho \cdot \delta u^2 \cdot u + \frac{1}{2} \cdot \rho \cdot (v^2 + w^2) \cdot u + (P_s - P_0) \cdot (u - U_0) )</td>
<td></td>
</tr>
<tr>
<td>ARNTZ_Ep</td>
<td>95 ( (P_s - P_0) \cdot (u - U_0) )</td>
<td></td>
</tr>
<tr>
<td>ARNTZ_Eth</td>
<td>109 ( \frac{1}{2} \cdot \rho \cdot \delta u^2 \cdot u )</td>
<td></td>
</tr>
<tr>
<td>ARNTZ_Eth_p</td>
<td>111 ( \frac{1}{2} \cdot \rho \cdot \delta u^2 \cdot u )</td>
<td></td>
</tr>
<tr>
<td>ARNTZ_Eth_t</td>
<td>110 ( \frac{1}{2} \cdot \rho \cdot \delta u^2 \cdot u )</td>
<td></td>
</tr>
<tr>
<td>BETZ_Vartificial</td>
<td>40 ( \sqrt{u^2 + \frac{2}{\rho} \cdot (P_{t_0} - P_t)} )</td>
<td></td>
</tr>
<tr>
<td>BETZ_p</td>
<td>42 ( P_{t_0} - P_t )</td>
<td></td>
</tr>
<tr>
<td>BETZ_profile_drag</td>
<td>42 ( \frac{P_{t_0} - P_t}{\rho} \cdot (u^* - u) \cdot (u^* + u - 2U_0) )</td>
<td></td>
</tr>
<tr>
<td>BETZ_u</td>
<td>42 ( \frac{P_{t_0} - P_t}{\rho} \cdot (u^* - u) \cdot (u^* + u - 2U_0) )</td>
<td></td>
</tr>
<tr>
<td>GILES_profile_drag</td>
<td>69 ( \frac{P_{s0} \cdot \delta s}{R} - \rho_0 \cdot \delta h_t )</td>
<td></td>
</tr>
<tr>
<td>Function</td>
<td>Page</td>
<td>Equation</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>JONES_profile_drag</td>
<td>43</td>
<td>$2 \sqrt{P_t - P_s} \left( \sqrt{P_{t0} - P_{s0}} - \sqrt{P_t - P_{s0}} \right)$</td>
</tr>
<tr>
<td>KUSUNOSE_lift</td>
<td>73</td>
<td>$\rho_0 U_0 y \xi - \rho_0 U_0^2 (1 - M_0^2) \frac{w}{U_0} (u - U_0) + M_0^2 \frac{\gamma P_{s0}}{R} \frac{w}{U_0} \delta_s - \rho_0 M_0^2 \frac{w}{U_0} \delta h_t$</td>
</tr>
<tr>
<td>KUSUNOSE_profile_drag</td>
<td>71</td>
<td>$P_{s0} \frac{\delta s}{R} - \rho_0 \delta h_t - \frac{P_{s0}}{2} \left( \frac{\delta s}{R} \right)^2 + \rho_0 \delta h_t \left( \frac{\delta s}{R} - \frac{M_0^2 \delta h_t}{2} \right)$</td>
</tr>
<tr>
<td>KUSUNOSE_total_drag</td>
<td>---</td>
<td>KUSU_profile_drag + KUSU_vortex_drag</td>
</tr>
<tr>
<td>KUSUNOSE_vortex_drag</td>
<td>72</td>
<td>$\frac{P_0}{2} \left( (v^2 + w^2) - (1 - M_0^2) \delta u^2 \right)$</td>
</tr>
<tr>
<td>Lamb_Vector</td>
<td>83</td>
<td>-$\omega \times V$</td>
</tr>
<tr>
<td>MASKELL_lift</td>
<td>63</td>
<td>$\rho_0 U_0 y \xi + \rho_0 (U_0 - u) w$</td>
</tr>
<tr>
<td>MASKELL_sideforce</td>
<td>---</td>
<td>$\rho_0 U_0 z \xi + \rho_0 (U_0 - u) v$</td>
</tr>
<tr>
<td>MASKELL_vortex_drag</td>
<td>48</td>
<td>$\frac{P}{2} \left( v^2 + w^2 \right)$</td>
</tr>
<tr>
<td>MEHEUT_profile_drag</td>
<td>74</td>
<td>$\frac{1}{S_{ref}} \left[ - \frac{2}{\gamma M_0^2} \Delta P_t - \Delta T_t + \left( 1 - \frac{M_0^2}{4} \right) \Delta T_t^2 - \Delta P_t \Delta T_t - (1 - M_0^2) \left( \Delta u^2 + 2 \Delta u^* \Delta \bar{u} \right) \right]$</td>
</tr>
<tr>
<td>MELE_induced_drag</td>
<td>88</td>
<td>$\rho l_x - m_\rho$</td>
</tr>
<tr>
<td>MELE_lift</td>
<td>87</td>
<td>$\rho l_z - m_\rho$</td>
</tr>
<tr>
<td>MELE_profile_drag</td>
<td>89</td>
<td>$-\rho x \times (n \times l)$</td>
</tr>
<tr>
<td>MOMENTUM_lift</td>
<td>34</td>
<td>$-\rho w u$</td>
</tr>
<tr>
<td>MOMENTUM_p</td>
<td>36</td>
<td>$-(P_s - P_{s0})$</td>
</tr>
<tr>
<td>MOMENTUM_sideforce</td>
<td>35</td>
<td>$-\rho v u$</td>
</tr>
<tr>
<td>MOMENTUM_stress</td>
<td>38</td>
<td>$-\mu \left[ \frac{2}{\sigma} \frac{\partial u}{\partial x} - \frac{2}{3} \left( \frac{\partial u}{\partial x} + \frac{\partial v}{\partial y} + \frac{\partial w}{\partial z} \right) \right]$ (See note 1)</td>
</tr>
<tr>
<td>MOMENTUM_total_drag</td>
<td>36</td>
<td>$-\rho (u - U_0) (u) + (P_s - P_{s0}) \right]$</td>
</tr>
<tr>
<td>MOMENTUM_u</td>
<td>36</td>
<td>$-\rho (u - U_0) (u)$</td>
</tr>
<tr>
<td>ONORATO_Pt</td>
<td>---</td>
<td>Pt0-Pt</td>
</tr>
<tr>
<td>ONORATO_drag</td>
<td>---</td>
<td>ONORATO_Pt + ONORATO_u + ONORATO_vw</td>
</tr>
<tr>
<td>ONORATO_u</td>
<td>---</td>
<td>$0.5 \times \text{Rho} \times (u-V0) \times 2$</td>
</tr>
<tr>
<td>ONORATO_vw</td>
<td>---</td>
<td>$0.5 \times \text{Rho} \times (v \times 2 + w \times 2)$</td>
</tr>
<tr>
<td>OSWATITSCH_profile_drag</td>
<td>44</td>
<td>$\frac{T_{s0}}{U_0} \rho u \delta s$</td>
</tr>
<tr>
<td>VDV_DeltaUbar</td>
<td>66</td>
<td>$U_0 \left( 1 - \frac{2}{(\gamma - 1) M^2} \left( e \frac{(\gamma - 1) \delta s}{\gamma - R - 1} + \frac{2 \delta h_t}{U_0^2} - 1 \right) \right)$</td>
</tr>
<tr>
<td>VDV_DeltaUstar</td>
<td>65</td>
<td>$\delta u - \delta \bar{u}$</td>
</tr>
<tr>
<td>VDV_profile_drag</td>
<td>67</td>
<td>$-\rho u \delta \bar{u}$</td>
</tr>
<tr>
<td>VDV_total_drag</td>
<td>---</td>
<td>VDV_profile_drag + VDV_vortex_drag</td>
</tr>
</tbody>
</table>

82
Notes:
- Note: The equation for the shear stress drag ignores the Reynolds stress term because Epsilon is mainly intended for the analysis of CFD RANS solutions with the Spalart Allmaras turbulence model, where the fluctuation terms are not available. The user must keep in mind that this neglected term is important especially for detached flows.

2 Epsilon Near Field

<table>
<thead>
<tr>
<th>VARIABLE NAME</th>
<th>ID</th>
<th>EQUATION CODED IN THE VARIABLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>F_friction</td>
<td>29</td>
<td>$-\tau \cdot \vec{n}$</td>
</tr>
<tr>
<td>F_pressure</td>
<td>29</td>
<td>$Ps \vec{n}$</td>
</tr>
<tr>
<td>F_total</td>
<td>29</td>
<td>$F_{pressure} + F_{friction}$</td>
</tr>
</tbody>
</table>
### 3 EPSILON POISSON SOLVER

<table>
<thead>
<tr>
<th>VARIABLE NAME</th>
<th>ID</th>
<th>EQUATION CODED IN THE VARIABLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>AGUIRRE_vortex_exergy</td>
<td>131</td>
<td>$\frac{1}{2} \rho (\psi \xi - \Phi \sigma) u^*$</td>
</tr>
<tr>
<td>MASKELL_vortex_drag</td>
<td>55</td>
<td>$\frac{\rho_0}{2} (\psi \xi - \Phi \sigma)$</td>
</tr>
<tr>
<td>Phi*Sigma</td>
<td>55</td>
<td>$\Phi \sigma$</td>
</tr>
<tr>
<td>Potential_Function</td>
<td>57</td>
<td>$\frac{1}{4\pi} \log[(y-y_w)^2+(z-z_w)^2]_{\text{model}} * \sigma(y_w,z_w)$ (See note 1)</td>
</tr>
<tr>
<td>Sigma</td>
<td>54</td>
<td>$-\frac{\partial u}{\partial x}$</td>
</tr>
<tr>
<td>Stream_Function</td>
<td>56</td>
<td>$\frac{1}{4\pi} \log[(y-y_w)^2+(z-z_w)^2]_{\text{model}} * \xi(y_w,z_w)$ (See note 1)</td>
</tr>
<tr>
<td>Vector_Speed</td>
<td>9</td>
<td>$V_x \hat{i} + V_y \hat{j} + V_z \hat{k}$</td>
</tr>
<tr>
<td>Vorticity_x</td>
<td>---</td>
<td>$\xi$</td>
</tr>
</tbody>
</table>
REFERENCES


